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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the begin-
ning to learn about SharePoint 2016 and then build your skills as you learn to perform 
increasingly specialized procedures. Or, if you prefer, you can jump in wherever you 
need ready guidance for performing tasks. The how-to steps are delivered crisply and 
concisely—just the facts. You’ll also find informative, full-color graphics that support the 
instructional content.

Who this book is for
Microsoft SharePoint 2016 Step by Step is designed for use as a learning and reference 
resource by beginning-level and intermediate-level users who want to use Share-
Point Server 2016 and/or SharePoint Online to create, modify, share, and manage 
sites, webpages, documents, and other content and capabilities; find information and 
people; and collaborate with others. Microsoft SharePoint 2016 Step by Step offers a 
comprehensive look at the capabilities and features of SharePoint Server 2016 and 
SharePoint Online that most people will use most frequently. The content of the 
book is designed to be useful for people who have previously used earlier versions of 
SharePoint and for people who are discovering SharePoint for the first time.

The Step by Step approach
The book’s coverage is divided into 14 chapters representing skill set areas. Chapters 1 
through 3 address foundation skills such as navigating a SharePoint site and working 
with documents and information in lists and libraries. Chapters 4 through 6 show you 
how to make lists and libraries work for you, how to work with search, and how to use 
My Site and Microsoft OneDrive for Business. Chapters 7 and 8 focus on working with 
webpages and creating and managing SharePoint sites. Chapter 9 considers the social 
capabilities of SharePoint 2016, such as community sites, blogs, and wikis. Chapters 
10 and 11 show you how to use business process features such as tasks and workflows. 
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Chapters 12 and 13 cover using SharePoint with Microsoft Office applications and the 
power of business intelligence. Finally, Chapter 14 drills into content management and 
monitoring.

TIP  The first part of Chapter 1 contains introductory information that will primarily be 
of interest to readers who are new to SharePoint. If you have worked with SharePoint 

before, you might want to skip past that material.

Each chapter is divided into topics that group related skills. Each topic includes 
expository information followed by generic procedures. At the end of the chapter, 
you’ll find a series of practice tasks you can complete on your own by using the skills 
taught in the chapter. The practice files for the practice tasks are available from this 
book’s website.

Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer from https://aka.ms/SP2016SBS/downloads. 
Follow the instructions on the webpage to install the files on your computer in the 
default practice file folder structure.

IMPORTANT  The SharePoint 2016 software is not available from the book’s website. 
You must have access to a SharePoint Server 2016 deployment before performing the 

practice tasks in this book. Alternatively, you can use SharePoint Online for most practice tasks 
in this book.

Whenever possible, we start each set of practice tasks with a standard SharePoint 2016 
team site, which occasionally must be a top-level team site. If you perform all the 
practice tasks in all the chapters, you might choose to start with a new team site for 
every chapter.

However, the practice tasks in Chapters 2 and 5 require additional settings for their 
practice sites. This is where the starter WSP files will come in handy. The starter WSP 
files contain lists, libraries, files, and pages that are needed for the practice tasks in the 
chapter. If you have sufficient rights, you can create a new practice site from the chap-
ter’s starter WSP file by following the detailed step-by-step installation instructions in 
the setup guide that is provided in the chapter’s practice folder.
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The following table lists the practice files supplied for this book. 

Chapter Folder File

1: Introduction to SharePoint 2016 Ch01 None

2: Navigate SharePoint sites Ch02 Chapter2_Setup.pdf
Chapter2FacilitiesSubsite.wsp
Chapter2TeamSite.wsp
Chapter2TravelSubsite.wsp
WideWorldTravelGuidelines.docx

3: Work with content in lists and libraries Ch03 OakChest.docx
OakDesk.docx
OakEndTable.docx
OakNightStand.docx
WideWorldPurchaseOrder.docx

4: Make lists and libraries work for you Ch04 Global Proposal.docx
Invoice.docx
Project.docx

5: Search for information and people Ch05 Chapter5_Setup.pdf
Chapter5.wsp

6: Work with My Site and OneDrive for Business Ch06 WideWorldImportersExpenses.
docx

7: Work with webpages Ch07 pjcov.jpg
Wildlife.wmv

8: Create and manage sites Ch08 None

9: Work with wikis, blogs, and community sites Ch09 Sales.jpg

10: Manage work tasks Ch10 None

11: Work with workflows Ch11 None

12: Collaborate with Office programs by using 
SharePoint

Ch12 Furniture_Price.xlsx
Sales_Figures.xlsx

13: Work with business intelligence Ch13 SalesData.xlsx

14: Manage and monitor content Ch14 HolidayPlanner.xlsx
WWI_Financials.xlsx
WWI_HolidayPlanner.xlsx
WWI_Presentation.pptx
WWI_ProductSheet.docx

xiii
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The practice tasks in this book cover features across SharePoint 2016 solutions 
deployed on-premises and SharePoint Online.

SharePoint Server 2016 solutions provide different sets of features and functionality 
depending on the client access licenses (CALs) activated in your organization. There 
are two SharePoint Server 2016 CALs, as follows:

■■ SharePoint Server 2016 Standard CAL

■■ SharePoint Server 2016 Enterprise CAL

SharePoint Online standalone subscription plans provide different sets of features and 
functionality depending on the plan you are subscribed to. There are two SharePoint 
Online plans, as follows:

■■ SharePoint Online subscription plan P1

■■ SharePoint Online subscription plan P2

To complete a practice task in this book, you need a SharePoint 2016 on-premises 
solution or SharePoint Online subscription plan that includes the SharePoint features 
used in that practice task.

SEE ALSO  For a list of the SharePoint 2016 solutions (Standard or Enterprise) and 
SharePoint Online plans (P1 or P2) you can use to complete each practice task, refer to 

Appendix B in the downloadable content. (The downloadable content for this book is available 
from the book’s Microsoft Press website at https://aka.ms/SP2016SBS/downloads.)

All practice tasks will work in SharePoint Server 2016 Enterprise. All practice tasks that 
cover features included in SharePoint Server 2016 Standard will work in SharePoint 
Server 2016 Standard. If you are using SharePoint Server 2016 Standard and a feature 
is not available in it, you will not be able to complete practice tasks that cover that 
feature. For example, the business intelligence features are available only in Share-
Point Server 2016 Enterprise; therefore, the practice tasks in Chapter 13, “Work with 
business intelligence,” require SharePoint Server 2016 Enterprise.

All practice tasks that cover features included in SharePoint Online P2 will work 
in SharePoint Online P2. Equally, all practice tasks that cover features included in 
SharePoint Online P1 will work in SharePoint Online P1. If you are using SharePoint 
Online P1 and a feature is not available in it, you will not be able to complete practice 
tasks that cover that feature. For example, the business intelligence features are only 

xiv

Introduction

https://aka.ms/SP2016SBS/downloads


available in SharePoint Online P2; therefore, the practice tasks in Chapter 13, “Work 
with business intelligence,” require SharePoint Online P2.

SEE ALSO  For SharePoint 2016 and SharePoint Online feature availability across 
solutions and subscription plans, refer to Appendix C in the downloadable content.  

(The downloadable content for this book is available from the book’s Microsoft Press website  
at https://aka.ms/SP2016SBS/downloads.) 

Ebook edition
If you’re reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
https://aka.ms/SP2016SBS/details.

Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. If you discover an error, please submit it to us at https://aka.ms/SP2016SBS 
/errata.

If you need to contact the Microsoft Press Support team, please send an email  
message to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to https://support.microsoft.com.
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at https://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at https://twitter.com 
/MicrosoftPress.
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3Work with 
content in lists 
and libraries

In this chapter
■■ Discover lists and libraries in a site

■■ Create and populate lists

■■ Create and populate libraries

■■ Check files out and work with 
versions

■■ Organize lists and libraries

■■ Delete and restore list items  
and documents

■■ Stay up to date with content 
changes

■■ Work offline

Practice files
For this chapter, use the practice files 
from the SP2016SBS\Ch03 folder. For 
practice file download instructions, 
see the introduction.

Microsoft SharePoint lists and libraries provide information 
management and collaboration capabilities. You can think 
of SharePoint 2016 lists as spreadsheets that you and your 
coworkers can simultaneously use. SharePoint lists repre-
sent editable, web-based tables that facilitate concurrent, 
multi-user interactions against a common, centralized, 
extensible set of columns and rows. All of the webpages 
you need to create, review, update, delete, and manage 
lists and their data are automatically and dynamically 
generated by SharePoint.

One of the most compelling features that SharePoint 2016 
provides is libraries. A library can be thought of as a list of 
files. Just as lists provide an effective way to work with all 
types of data they contain, SharePoint libraries function 
similarly for documents and files, such as Microsoft Word 
documents. By using SharePoint document libraries, you 
can filter and group documents and view metadata for 
documents stored in the library.

This chapter guides you through procedures related 
to discovering lists and libraries in a site, creating and 
populating lists and libraries, checking files out and 
working with versions, organizing lists and libraries, 
deleting and restoring list items and documents, staying 
up to date with content changes, and working offline.
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Discover lists and libraries in a site
SharePoint 2016 includes several templates that you can use to create the default 
types of lists and libraries. In SharePoint, each list and library is implemented as an 
app. You can choose a template app from the list and library apps available in the 
Your Apps page to generate a new list or library with a specific predefined function-
ality and set of columns. Each list or library app has a specific purpose, and its tile 
visually indicates the type of list or library the app will create. Later in this chapter, the 
“Organize lists and libraries” topic explores how to add, alter, and delete columns in 
lists and libraries; most default columns can be altered or deleted, even after data has 
been entered into them.

There are 20 list apps and 10 library apps provided by SharePoint 2016; these are 
described in the following table.

TIP  Your site might provide a different number of default list and library apps, depend-
ing on your SharePoint 2016 edition, the enabled features, or the Microsoft Office 365 

plan that your organization subscribes to.

List apps

Tile List app Description

Announcements Create an announcements list when you want a place to 
share news, status, and other short bits of information.

Calendar Create a calendar list when you want a calendar-based 
view of upcoming meetings, deadlines, and other 
important events. You can share information between 
your Calendar list and Microsoft Outlook.

Circulations Create a circulations list when you want publications to be 
sent to specific recipients. This list contains many unique 
capabilities for distributing information to these selected 
users.

Contacts Create a contacts list when you want to manage 
information about people your team works with, such 
as customers or partners. You can share information 
between your contacts list and Outlook.

Custom List Create a custom list when you want to specify your own 
columns. The list opens as a webpage on which you can 
add or edit items one at a time.

Chapter 3: Work with content in lists and libraries
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List apps

Tile List app Description

Custom List
In Datasheet View

Create a custom list in Datasheet view when you 
want to specify your own columns. The list opens in a 
spreadsheet-like environment for convenient data entry, 
editing, and formatting.

Discussion Board Create a discussion board when you want to provide a 
place for newsgroup-style discussion. Discussion boards 
provide features for managing discussion threads and 
ensuring that only approved posts appear.

External List Create an external list to work with data that is stored 
outside of SharePoint, but that you can read and write 
within SharePoint. The data source for an External List is 
called an External content type. Unlike a native SharePoint 
list, an External List uses Business Connectivity Services to 
access data directly from an external system.

Import 
Spreadsheet

Import a spreadsheet when you want to create a list 
that has the same columns and contents as an existing 
spreadsheet. Importing a spreadsheet requires Microsoft 
Excel.

Issue Tracking Create an issue tracking list when you want to manage a 
set of issues or problems. You can assign, prioritize, and 
follow the progress of issues from start to finish.

KPI List Create a KPI list to track key performance indicators (KPIs) 
and to display the status of each indicator on a dashboard 
page. You can set up KPI lists to track performance by 
using one of four data sources: manually entered data, 
data in a SharePoint list, data in an Excel workbook, or 
data from Microsoft SQL Server Analysis Services (SSAS).

Languages And 
Translators

Create a languages and translators list to use with a 
Translation Management workflow. The workflow uses the 
list to assign translation tasks to the translator specified in 
the list for each language.

Links Create a links list when you have links to webpages or 
other resources that you want to share.

Microsoft IME 
Dictionary List

Create a Microsoft IME dictionary list (IME stands for 
Input Method Editor) when you want to use data in the list 
as a Microsoft IME dictionary.
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List apps

Tile List app Description

PerformancePoint 
Content List

Create a PerformancePoint content list to store dashboard 
items, such as scorecards, reports, filters, dashboard 
pages, and other dashboard items that you create by 
using PerformancePoint Dashboard Designer.

Project Tasks Create a Project Tasks list when you want a graphical 
view (a Gantt chart) of a group of work items that you or 
your team needs to complete. You can share information 
between your Project Tasks list and Outlook.

Promoted Links Create a Project Tasks list when you want a graphical 
view (a Gantt chart) of a group of work items that you or 
your team needs to complete. You can share information 
between your Project Tasks list and Outlook.

Status list Create a status list to display and track the goals of 
your project. The list includes a set of colored icons to 
communicate the degree to which goals are met.

Survey Create a survey when you want to poll other users of the 
website. Surveys provide features that you can use to 
quickly create questions and define how users specify 
their answers.

Tasks Create a tasks list when you want to track a group of work 
items that you or your team must complete.

Library apps

Tile Library app Description

Asset Library Create an asset library to share and manage digital media 
assets, such as image, audio, and video files. An asset 
library provides content types, with properties and views 
such as thumbnails and metadata keywords for managing 
and browsing media assets.

Dashboards Library Create a dashboards library to contain PerformancePoint-
deployed dashboards.
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Library apps

Tile Library app Description

Data Connection 
Library

Create a data connection library to simplify the 
maintenance and management of data connections. A 
data connection library is a centralized place to store 
Office Data Connection (ODC) files. Each of these files 
(which have an .odc extension) contains information 
about how to locate, log on to, query, and access an 
external data source.

Document Library Create a document library when you have a collection 
of documents or other files that you want to share. 
Document libraries support features such as folders, 
versioning, and checking out.

Form Library Create a form library when you have XML-based business 
forms, such as status reports or purchase orders, that you 
want to manage. These libraries require an XML editor, 
such as Microsoft InfoPath.

Picture Library Create a picture library when you have pictures you want 
to share. Picture libraries provide special features for 
managing and displaying pictures.

Record Library Create a record library to keep a central repository for 
storing and managing your organization’s records or 
important business documents. You can set policies 
that determine what records to store, how to route and 
manage the documents, and how long these records 
must be retained.

Report Library Create a report library to simplify the creation, 
management, and delivery of webpages, documents, 
and KPIs of metrics and goals. The report library is a 
central place where you can create and save reports and 
dashboards.

Process Diagram 
Library

Create a process diagram library to store and share 
process diagram documents, such as those created with 
Microsoft Visio.

Wiki Page Library Create a wiki page library when you want to have an 
interconnected collection of wiki pages that multiple 
people can use to gather information in a format that is 
easy to create and modify. Wiki page libraries support 
pictures, tables, hyperlinks, and internal wiki linking.
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To display all apps available on your site

1.	 Go to the Your Apps page by doing any of the following:

●● On the Settings menu, select Add an app.

●● On the Quick Launch, select Site Contents, and then on the Site Contents 
page, select the add an app tile.

●● On the Get started with your site page, select the Add lists, libraries, and 
other apps tile.

To display the list apps available on your site

1.	 Display the Your Apps page.

2.	 In the search box at the top of the page, enter list.

3.	 Press Enter on the keyboard or select the Search icon.

Your SharePoint setup determines which list apps are available on your site

To display the library apps available on your site
1.	 Display the Your Apps page.
2.	 In the search box at the top of the page, enter library.

3.	 Press Enter on the keyboard or select the Search button to start the search.
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Your SharePoint setup determines which library apps are available on your site

Create and populate lists
SharePoint lists empower you to provision your own repositories of structured infor-
mation in which list items behave like rows consisting of self-labeled columns. After 
you’ve provisioned a list, you can create and edit list items in several ways, either one 
by one by using a form on a separate page, or within the list page in a grid that is 
similar to a spreadsheet.

Create lists
The first step in creating a new list is to ask yourself, “What kind of information do 
I want to gather (or display)?” The answer to this question will help you determine 
which list app to choose. Perhaps you want to start with a list that is close to your end 
goal and then add, delete, and alter the default columns to provide the solution you 
are trying to achieve. For example, if you are planning to collect information such as 
names and addresses, you can choose the Contacts list app to create your initial list, 
and then modify it. Or perhaps you want to start with a bare-bones list and build it 
entirely from scratch. In that case, you would likely choose the Custom List app to 
create your initial list.

TIP  If the list items in the list you want to create always contain files, consider using a 
document library instead of a list. 
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When you create a list, a new tile for the list is added to the Site Contents page, with 
a green “new” icon to the right of the tile. A link to the new list is shown on the Quick 
Launch, in the Recent section.

TIP  The link to the new list in the Recent section on the Quick Launch is displayed 
temporarily. When more lists and libraries are created, their links take precedence over 

the older ones in the Recent section. The Recent section displays five of the newest links.

The Site Contents page with a new tile for the new BuyerTasks list and a new BuyerTasks link in the  
Recent section on the Quick Launch

When you initially create a list in SharePoint, you are establishing two name values: 
the display name, usually labeled Name or Title; and the URL name, also known as the 
internal name. The display name is used to populate both names. However, only the 
display name can be changed after the list is created.

After the list has been created, it is often useful to modify a list’s display name so that 
it is more descriptive than the initial name that is used in the URL. The revisions to the 
list name only affect the display name and not the URL name. For example, if the list 
was named BuyerTasks without a space between Buyer and Tasks, it would be useful 
to change the display name so that it has a space in it.

TIP  Best practices to follow when initially naming a list in SharePoint include the 
following: The initial name should be descriptive, intuitive, and easy to remember. It 

should be concise and should not contain spaces (a space gets converted to %20 in the URL). 
The initial name should be consistently used throughout the site. Your organization might also 
have specific naming conventions that you will want to follow. 

To create a list
1.	 Display the Your Apps page.

2.	 Select the tile for the type of list you want to create, such as Tasks or Contacts. 
The Adding dialog box opens.
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3.	 In the Name box, enter a display name for the new list. This box also supplies 
the value that SharePoint uses for the new list’s URL.

Creating a new Tasks list

4.	 Select Create.

TIP  Selecting Advanced Options allows you to provide both a name and a description 
for your new list at the time of creation. You can change the list name and description 

after the list has been created.

To change the display name of a list
1.	 On the Settings menu, select Site Contents to go to the Site Contents page.
2.	 Locate the tile for the list whose display name you want to change, and select 

the tile to go to the default list view page for the list.
3.	 In the upper-left of the page, select the List tab, and then at the right end of 

the List tab, in the Settings group, select List Settings.

Select List to display the List tab

4.	 On the Settings page, in the General Settings area, select List name, description 
and navigation.

Selecting List Name, Description And Navigation in the General Settings area  
in the Settings page for a list
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5.	 On the General Settings page, in the Name box, replace the initial list name by 
entering a new display name.

The General Settings page, with Common Buyer Tasks entered in the Name box

TIP  On the General Settings page, you can enter the list description and choose 
to permanently display the list link on the Quick Launch.

6.	 Select Save to save the change.

TIP  Notice that the list name on the top of the page and the link on the Quick Launch 
now reflect the modified display name. However, if you navigate to the list default page, 

you can see that the browser’s address bar still reflects the initial name (internal name) given to 
the list when it was created.

Add and edit list items
Creating a SharePoint list automatically generates the pages you need to view the list 
as a whole, view a list item, add a new list item, and edit an existing list item.

A view defines how the information in a list or library is displayed to the users. Although 
some lists only have a single view when they are created, SharePoint generates multiple 
list views for others. For example, when a new Tasks list is created, the following seven 
list views are generated: All Tasks (the default), Calendar, Completed, Gantt Chart, Late 
Tasks, My Tasks, and Upcoming. You can navigate to a list default view page from other 
locations by selecting the list name on the Quick Launch. When you display a list, several 
links for the views available for that list are shown at the top of the list. You can display 
more links to list views by selecting the ellipsis to the right of the displayed view links.
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You can create and edit list items individually by using a form on a separate page, or you 
can create and edit items within the list page, in a grid that is similar to working in Excel. 
The grid is referred to as a datasheet view, also known as a Quick Edit view or just a Quick 
Edit. It is handy when you need to add or edit multiple list items.

TIP  When you use Quick Edit, you can only enter values for columns featured in the 
view you are currently using. When you use list item forms, you can enter values into all 

available columns.

After you have created a list item, the new item is displayed on the list default view 
page with a green icon to its right.

A new list item on a Task list page

Occasionally, you might want to attach one or more documents to a list item. You 
can do so by using the Attach File command on the Items tab. By default, all lists in 
SharePoint allow attachments. However, if every list item always has one and only one 
document, reconsider the use of a list and opt for a document library instead.

To add a list item

1.	 Go to the list’s default view page and do one of the following:

●● In the body of the page, at the top of the list, select the plus sign.

●● In the body of the page, at the top of the list, select new item. (In a Tasks 
list, the new item link is displayed as New Task.)

The New Task link

●● On the Items tab of the ribbon, select New Item. (In a Tasks list, the Items 
tab is named Tasks.)
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2.	 On the list item page, provide the list item details. For example, if you are creating 
a new task, in the Task Name box, enter the new task name.

Creating a new task

3.	 Select Save to save the new item and return to the list default view page.

To add list items in a Quick Edit view

1.	 Open the list default view page.

2.	 In the body of the page, select edit to the right of the new item (or new task) 
link to display the list as a grid in the Quick Edit view (also known as the data-
sheet view), with a new empty row at the bottom.

3.	 Fill in the details of the new list item in the empty row. For example, for a new 
task, enter a name in the Task Name column and a date for when the task is 
due in the Due Date column.

Creating a list item in the Quick Edit view

TIP  In Quick Edit, you can enter values only for columns featured in the view you 
are using. In list item forms, you can enter values into all available columns.

You can use the empty row at the bottom of the grid to add more list items if 
you want to.

4.	 When you have finished adding items, select Stop at the top of the list to return 
to the default view.
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To edit a list item

1.	 On the list default view page, select the list item you want to edit by clicking or 
tapping in its leftmost column.

Selecting a list item

2.	 Select Items at the top of the page to display the ribbon. (The actual name of 
the Items tab depends on the type of list you are working with—for example, it 
could be called Tasks or Contacts.)

The Tasks tab

3.	 In the Manage group, select Edit Item to open the list item page in edit mode.
4.	 Make the changes you want. For example, in a Tasks list, for a completed task, 

you can enter 100 in the % Complete box to mark the task as completed.

Editing a list item

5.	 When you have finished making your edits, select Save to return to the list 
default page.

To attach a document to a list item
1.	 Open the list default view page.
2.	 In the body of the page, select the list item you want to attach a document to 

by clicking or tapping in its leftmost column.
3.	 On the Items tab, in the Action group, select Attach File to open the Attach File 

dialog box.

Attaching a file
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4.	 Select Browse to open the Choose File To Upload dialog box.

5.	 Navigate to the file you want to attach to the list item, and select Open to 
return to the Attach File dialog box. The location of the selected document is 
displayed in the Name box.

IMPORTANT  At this point, the document is only associated with the list item in 
memory. Closing the browser abandons the attachment. You must select OK to 

save the attachment’s association with this task. 

6.	 Select OK to upload the document and attach it to the list item.

Create and populate libraries
A library is a location in a site where you can create, collect, update, and manage doc-
uments and other files with other team members. Each library displays a list of files 
and key information about the files, which helps people use the files to work together. 
In the business world, being able to work with documents quickly and effectively is of 
paramount importance.

You can use libraries to store your documents and other files on a SharePoint site 
rather than on your local computer’s hard drive, so that coworkers can find and work 
with them more easily. Libraries are used to store files, whereas lists are used to store 
other types of content. Like lists, libraries contain metadata stored in columns that 
you can use to filter, sort, and group the items.

After you have created a library, you can populate it with files. For example, you can 
upload existing documents into a document library, or you can create new documents 
from within the library based on the default document template for the library. After 
documents are placed in the library, you can search and filter them to make it easier 
to find what you are looking for, and you can collaborate with others to help develop 
the final version of a document. You can edit documents in a SharePoint library by 
using an Office client program such as Word or an Office Online program such as 
Word Online.

Create libraries
When you create a new SharePoint team site, a generic document library called 
Documents is created. Because this library lacks a descriptive name, a best practice 
is to create a new library for a particular business category or subject instead of just 
using the Documents library for your documents. Make sure that the names of your 
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document libraries are descriptive and that each library has a specific topic, to make 
it easier to find documents. Storing all documents together in the default Documents 
library—or any one document library—defeats the purpose of using SharePoint sites 
to make information easier to locate.

When a library is created, a new tile for this library is added to the Site Contents page 
with a green “new” icon to the right of the tile. A link to the new library is shown on 
the Quick Launch, in the Recent section.

The Site Contents page with a new tile for the newly created Furniture library and a new link to the library in 
the Recent section on the Quick Launch

The procedure in this section also applies to creating types of libraries other than 
document libraries.

To create a library

1.	 Display the Your Apps page.

2.	 Select the tile for the type of library you want to create, such as Document 
Library. The Adding Library dialog opens.

3.	 In the Name box, enter a name for the new library, such as Furniture.

Creating a new library

4.	 Select Create.

Create and populate libraries

67



Upload existing files
There are several ways to add existing files to a library, including the following:

■■ You can use your browser to upload files to the library via the SharePoint 
interface.

■■ You can use File Explorer to copy or move files into the library, such as by dragging 
them from your desktop or any other location to SharePoint.

■■ You can use sync to upload files that are stored offline.

This section focuses on the first two methods: using your browser and using File 
Explorer. The “Work offline” topic later in this chapter covers using sync to add a file 
to a library.

To add a file to a library by using a browser

1.	 Go to a library you want to add a file to.

2.	 Do one of the following to open the Add A Document dialog:
●● In the library, in the body of the page, select Upload.

●● On the keyboard, press Alt+U.

Uploading a file to a library

3.	 Select Browse to open the Open dialog, browse to the file you want to upload, 
select the file, and then select Open.

TIP  You can upload a file of up to 10 gigabytes (GB) in size. 

4.	 In the Add a document dialog, select OK to confirm the upload and return to 
the library.

TIP  You can add one file at a time by using this method. To upload multiple files at the 
same time, use the dragging method or the copy-and-paste methods covered in the 

next two procedures. 
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To add files to a library by dragging

1.	 In a library you want to add files to, open File Explorer, and navigate to the 
folder where the files you want to add are located.

2.	 Position the File Explorer window next to the browser window displaying the 
library so that you can drag files from File Explorer to the browser.

3.	 In File Explorer, select the files to upload by doing one of the following:

●● To add one file, select the file.

●● To add multiple files, press and hold down the Ctrl key when you select the files.

4.	 Drag the files to the library in the browser window, to where it says Drag files 
here to upload.

Drag files to where it says “Drag files here to upload”

TIP  When you drag files into a browser window, the Drop Here box appears, 
identifying the broader area on the page where you can drop the files.

5.	 After the upload, select Dismiss at the top of the documents list to dismiss the 
confirmation message that an upload has been completed.

To add files to a library by using copy and paste

1.	 In a library you want to add a file or files to, on the Library tab, in the Connect 
and Export group, select Open with Explorer.

The Library tab
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The library content is displayed in File Explorer. Displaying the SharePoint 
library content in File Explorer is referred to as an Explorer View.

TIP  The Open With Explorer button is typically disabled for an unsupported 
browser or unsupported operating system. If the button is unavailable, your 

browser might not be compatible with SharePoint.

2.	 Open another instance of File Explorer, navigate to the folder where the files 
you want to add are located, and select the files.

3.	 Copy the files by doing one of the following:

●● In File Explorer, from the shortcut menu, select Copy.

●● Press Ctrl+C on the keyboard.

TIP  When you cut and paste, you are moving the file. When you copy and paste, 
or drag from File Explorer to a SharePoint library, you are copying the file. 

4.	 Go to the File Explorer window that is displaying the library files, and do one of 
the following to add the files to the library:

●● From the document’s shortcut menu, select Paste.

●● Press Ctrl+V on the keyboard.

TIP  In the browser where the library is displayed, refresh the page to verify that 
the files are listed in the library. 

Create documents from a library
You can create new Office documents directly from a SharePoint library. A new docu-
ment will be based on a default template for the library.

You can create a new document in the Office client program, such as Word, if it is 
installed on your device. You can also create it in your browser, by using an Office 
Online program such as Word Online.

To create a document from a library by using an Office Online program such as 
Word Online

1.	 Go to a library in which you want to create a document.

2.	 Do one of the following:
●● In the document library, in the body of the page, select New.

●● On the keyboard, press Alt+N.
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3.	 Select the type of document you want to create.

Types of Office documents that can be created from a library

A new document opens in the Office Online program you selected. For example, 
selecting Word Document opens Word Online.

IMPORTANT  At the time of writing, selecting a type of document is available in 
SharePoint Online. In SharePoint on-premises, selecting the New link displays the 

Add A Document dialog that you can use to upload a file, as discussed in the previous 
section, rather than create a new document.

A new document in Word Online

TIP  Depending on your server settings, the new document will open either in 
your browser in Word Online or in the Word client program, if it is installed on 

your device. If the new document opens in the Word client, go the next procedure. 
Otherwise, continue to the next step.
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4.	 The new document is automatically saved in the library with the default name 
that is shown in the title bar, such as Document. To rename the document, 
select its name in the title bar, enter the new name, and then press Enter.

5.	 Add the content you want to the new document.

TIP  If you require access to features that are available only in the full Office 
program, you can switch to the full Office client program. For example, in Word 

Online, select Open In Word to continue working on the document in Word.

6.	 When you’re done, return to the library where the file is saved by doing one of 
the following:

●● Select the site link in the title bar, to the left of the file name.

●● Select the Back button in your browser.

7.	 On the library page, select Refresh to confirm that your new document is now 
listed in the library.

Office Online programs
The Office Online programs, or apps, are part of Office 365 and are avail-
able if you are using SharePoint Online. If you are using SharePoint 2016 
on-premises, the Office Online Server (OOS) in your organization must be 
installed and activated before you can create or edit documents in the Office 
Online programs such as Word Online, Excel Online, PowerPoint Online, and 
OneNote Online. If OOS is installed and activated, you can view and, depend-
ing on your organization’s license terms, edit Office documents by using a 
supported web browser on computers and on various mobile devices and 
tablets, such as Windows Phones, iPhones, iPads, and Android tablets and 
phones. The Office Online programs can be used from any device where a 
browser is available; however, they have less functionality in comparison with 
Office client programs such as Word, Excel, PowerPoint, and OneNote.
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To create a document from a library by using Word

1.	 Go to a library in which you want to create a document.

2.	 On the Files tab, in the New group, select New Document.

The New group on the Files tab

TIP  Depending on your server settings, the new document will open either in 
the Word client program or in Word Online. If the new document opens in Word 

Online, select Edit In Word on the title bar.

3.	 A new document opens in the Word client program. If a warning about allow-
ing this website to open a program on your device appears, select Allow.

TIP  New Word documents created from SharePoint are based on the default 
template for the SharePoint library, which is called template.dotx. If a warning 

about this template appears, select Yes to confirm that you want to proceed with 
opening a file.

4.	 If prompted, provide your user name and password for the SharePoint site.

5.	 If a Read-Only banner appears at the top of the document, select Edit 
Document.

The Read-Only banner that appears when a SharePoint document is opened in Word

6.	 Add the content you want to the new document.

7.	 When you’re done, go to the File tab and select Save to save the document to 
the document library.
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8.	 To name the file, under Current Folder, select the library to open the Save As 
dialog box. Note that the location points to the document library.

9.	 Enter the name of the new document, and then select Save.

10.	 In the browser, refresh the library page to confirm that your new document is 
listed in the library.

Edit documents
In SharePoint, you can edit documents in Office client programs such as Word and 
Excel or in your browser by using Office Online apps that provide online companion 
web apps to Office client programs, such as Word Online or Excel Online. (For more 
information, see the “Office Online programs” sidebar earlier in this topic.)

When you’re on the move, it is often very useful to be able to edit your documents 
within a browser, without the need for the client program to be installed on the 
device you’re using.

To edit a document in an Office client program from a library

1.	 Go to the library that contains the document you want to edit.

2.	 Open the document for editing in the Office client program by doing one of 
the following:

●● Select the ellipsis to the right of the document’s name, and in the callout 
that opens, do one of the following:

●● Select Open.

●● Select the ellipsis, and then select Open in Word.

Opening a Word document for editing in the Word client
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●● Display the document’s shortcut menu, and then select Open in Word.

●● Select the document by clicking or tapping in its leftmost column, go to the 
Files tab, and then select Edit Document.

The Edit Document button on the Files tab

TIP  Depending on your server settings, you might be able to just click or tap the 
document you want to edit to open it. The document will open in either the 

Office Online app in your browser, or in the Office client program, if it is installed on 
your device. If the document opens in Office Online in your browser, in the title bar, 
select Edit Document. If the document opens in Office Online for viewing, open the Edit 
Document menu and select Edit In Word. In either case, you can then continue to the 
next step.

3.	 The document opens in the Office client program such as Word. Do the 
following:

●● If a warning about allowing this website to open a program on your 
computer appears, select Allow.

●● If a warning about the document appears, select Yes to confirm that you 
want to proceed with opening a file.

●● If prompted, provide your user name and password for the SharePoint site.

●● If a Read-Only banner appears at the top of the document, select Edit 
Document.

4.	 In Word, edit the document.

5.	 On the File tab, select Save to save the document to the document library.

TIP  You can configure whether your device opens a document within your browser or 
in the document’s native Office client program. The default option is to open in a 

browser by using Office Online apps, such as Word Online, so that users can use their browsers 
to view their documents online. For on-premises deployments, this capability depends on 
Office Online programs being installed and activated on the server in your organization. For 
more details, see Chapter 4, “Make lists and libraries work for you.” 
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To edit a document in Office Online from a library

1.	 Go to the library that contains the document you want to edit.

2.	 Open the document in its corresponding Office Online app by doing one of the 
following:

●● Display the document’s shortcut menu by right-clicking the document 
name, or on touch devices by pressing and holding the document name, 
and select Open in Office App Online (for example, Open In Word Online).

Opening a document in Word Online

●● Select the ellipsis to the right of the document’s name, and in the callout 
that opens, select the ellipsis, and then select Open in Office App Online 
(for example, Open In Word Online).

●● Click or tap the document you want to edit.

3.	 The document opens in Office Online. If the document opens for viewing, 
select Edit Document and then select Edit in Office App Online (for example, 
Edit In Word Online).

When you make your edits, the document is saved automatically.

4.	 When you’re done, return to the library where the file is saved by doing one of 
the following:

●● Select the site link in the title bar, to the left of the file name.

●● Select the Back button in your browser.

5.	 In the library, select Refresh and confirm that the document has been saved to 
the library by checking its timestamp.

TIP  If you open a document in Office Online and the Edit Document option is 
unavailable, it means that Office Online programs have not been activated for 

editing in your environment.
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To rename a file in a library

1.	 In the library that contains the file you want to rename, display the file’s short-
cut menu, and select Rename.

2.	 On the file page, enter a new name in the Name box, and select Save.

Renaming a document

Check files out and work with versions
SharePoint 2016 provides several content management capabilities, including checking 
files in and out and version control.

Check files in and out
Checking out and checking in documents and other files lets others know what 
documents you are working on so that they don’t work on them at the same time.

When you check out a file, you lock the file for editing to prevent other users from 
editing the file at the same time. When you are done editing the file, you check the 
file back in, allowing other users to edit the file. When you check in a document, you 
can also enter comments about what you’ve changed so that others can see them.

When you want to check out and edit a document, whether you plan to edit it online 
or download it to the client program, the following sequence is recommended:

1.	 Check out the document.

2.	 Download the document and open it in the client program, or open the docu-
ment in an Office Online app.

3.	 Edit the document.

4.	 Upload the document, if necessary. (If you used Office Online, your edits are 
automatically saved.)

5.	 Check in the document.

Check files out and work with versions

77



When a document has been checked out, the file icon changes to include a green, 
downward-pointing arrow, indicating that the document is now checked out. No one 
else can change this document, and no one else can see your changes while you have 
it checked out.

A checked-out document

TIP  Point to the file icon to display the name of the person that the file is checked out to. 

When a document is checked out to you, only you can do anything with the file. 
However, checking out a document is only the first step. You still need to open the 
file, download it, or edit it online. Finally, after you have finished your edits and saved 
the document back to the library, you need to check it back in.

TIP  If you check out a file and don’t make changes to it, or if you make changes that 
you don’t want to keep, you can discard the checkout, rather than saving and checking 

in the file. 

To check a file out from a library

1.	 Go to a library where you want to check out a file.

2.	 Do either of the following:
●● Select the file or files that you want to check out by clicking or tapping in 

the column to the left of each file. Then, at the top of the page, select the 
Files tab, and in the Open & Check Out group, select Check Out.

●● Right-click (or on touch devices press and hold) the file that you want to 
check out, and on the shortcut menu, select Advanced, and then select 
Check Out.
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Display the Advanced shortcut menu by right-clicking or pressing and holding  
the file name and then selecting Advanced

To check a file in to a library

1.	 Go to the library where you want to check in a file.

2.	 Do either of the following:
●● Select the file that you want to check in by clicking or tapping in its leftmost 

column, go to the Files tab, and then in the Open & Check Out group, 
select Check In.

●● On the shortcut menu for the file you want to check in, select Advanced, 
and then select Check In.

3.	 In the Check in dialog, in the Retain Check Out area, select Yes if you want 
to do an interim check-in so you can continue working on the file. Otherwise, 
leave the default option No selected.

The Check In dialog

4.	 In the Comments box, enter a comment that describes the changes you made. 
Although this is optional, it is recommended as a best practice.

5.	 Select OK. The file is checked back in and the green arrow disappears from the 
file icon.
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To discard a checkout

1.	 Go to the library where you want to discard a checkout.

2.	 Do either of the following:
●● Select the file for which you want to discard the checkout by clicking or 

tapping in its leftmost column, go to the Files tab, and then in the Open & 
Check Out group, select Discard Check Out.

●● On the shortcut menu for the file that you want to check in, select 
Advanced, and then select Discard Check Out.

3.	 In the message box that appears, select OK.

Work with version history
When versioning is enabled in your list or library, SharePoint 2016 creates a separate 
copy of the list item or document each time it is edited. With versioning, you can 
store, track, and restore items in a list and files in a library whenever they change. 
Although this takes up extra space on the server, it also makes it easy to revert to an 
older version of the list item or document if necessary.

A library can be configured to keep only major versions or both major and minor 
versions. Major versions are indicated with whole numbers, such as 1, 2, 3, and so on. 
Minor versions are indicated with decimals, such as 1.1, 1.2, 1.3, and so on. A major 
version number is associated with a version that has been published. A minor version 
number is associated with a version that is in progress but that has not yet been 
published.

Major versions are available for lists, but minor versions are not. Each version of a list 
item is numbered with a whole number.

When you view a document’s version history, SharePoint displays a list of the 
occasions when this document was edited and saved, and the author’s comments on 
those changes. From this list you can restore an older version of the document. The 
restored version becomes the new current version.

To view the version history of a file

1.	 Go to the library that contains the file.

2.	 Do either of the following:
●● Select the file by clicking or tapping in its leftmost column and then, on the 

Files tab, in the Manage group, select Version History.

●● Display the shortcut menu for the file, and then select Version History.

Chapter 3: Work with content in lists and libraries

80



3

To view an earlier version of a file without overwriting your current version

1.	 Display the version history of the file.

2.	 In the Version History dialog, do either of the following for the file version you 
want to view:

●● Select the date/time stamp of the file version.

●● Point to the date/time stamp of the file version, select the arrow that 
appears, and select View from the menu.

. 
The Version History dialog

Then select the document name in the Version History form.

The Version History form for a document that is checked out

Depending on the settings in the library, the document opens for viewing in 
Word Online or as a read-only document in the Word client program, if it is 
installed on your device.
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To restore an earlier version of a file

1.	 Display the version history of the file.

2.	 In the Version History dialog, point to the date/time stamp of the file version, 
select the arrow that appears, and then select Restore from the menu.

3.	 In the confirmation dialog box, select OK to replace the current version with the 
selected version.

TIP  There will now be a new version shown in the Version History dialog that is a 
copy of the earlier version that you have restored. If major versioning is enabled, 

this is the latest version that is published on the site. If minor versioning is enabled, the 
restored version is shown as an additional, unpublished version. SharePoint 2016 
actually copies the version you want to restore and makes it the newest minor version. If 
you want to publish this version, you need to do so manually by using the Publish 
button on the ribbon.

4.	 Close the Version History dialog box to return to the library.

Organize lists and libraries
When a list or a library grows to large number of items, you often need to organize 
the content so that you and other users can quickly find information.

You can organize your content into folders. In SharePoint 2016, you can create folders 
in libraries and lists.

You can also use columns in lists or libraries to group, categorize, sort, and filter 
information. You can create, change, hide, and delete the list and library columns. 
These columns can be of multiple types, such as a single line of text, a drop-down list 
of options, a number that is calculated from other columns, and many others. You can 
create custom views to save the column and filter setup.

Create folders in a list or a library
Using folders is a common way to organize documents efficiently. SharePoint 2016 
provides other mechanisms for organization of your documents, including views and 
filters. However, many people are most familiar with folders and thus find it easier to 
create a folder structure.
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To create a new folder
1.	 Go to a library where you want to create a folder.
2.	 Do one of the following:

●● On the Files tab, in the New group, select New Folder.
●● In the body of the page, select New, and then select New Folder.

TIP  You can create a new folder in most lists in the same way, by selecting  
New Folder in the New group on the Items tab. The list must be set up to allow 

creation of folders. The ability to create folders is a default setting for several lists, such 
as the Links list.

3.	 In the Create a folder dialog that opens, in the Name box, enter the name for 
the new folder, and then select Create.

The Create A Folder dialog

Add, edit, and remove list and library columns
The list and library apps in SharePoint 2016 provide an easy way to generate a list or 
a library with very little effort. And if you need to customize the list and library views, 
you can easily add, edit, and remove list and library columns in addition to creating 
additional custom columns by using the Settings page for the list or library. In addi-
tion, for a list, you can use Quick Edit view to add new columns, without leaving the 
list page.

There are many types of columns that can be added to a list or a library, including 
columns for a single line of text, currency values, date and time, a Yes/No check box, 
and a drop-down list of options. You can hide a column from being displayed in a 
list or a library view, and most columns in a list or library can be deleted. However, 
there are some columns that you cannot delete. All lists have at least one column 
that cannot be deleted. For instance, the Title column can be renamed but not 
deleted. Some lists also prevent the deletion of certain columns, so that the list can 
be displayed properly or integrate with Office programs properly. For example, the 
Assigned To, Status, and Category columns of any list based on the Issues list app 
cannot be deleted, and none of the default columns in any list based on the Calendar 
list app can be deleted.
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There are five columns that are automatically created and populated for each list item 
or file in a library that cannot be changed: ID, Created, Created By, Modified, and 
Modified By. The ID column ensures that the list or library item is unique in the list 
or library. It contains a sequential number beginning with 1 and increments by 1 for 
each new list or library item. SharePoint automatically captures when the list or library 
item was created, who it was created by, when it was last modified, and who it was last 
modified by. Initially, the Created and Modified columns are equal, as are the Created 
By and Modified By columns.

You can choose which columns are displayed in a list or library. This can be done both 
with custom and default columns. You can also change the order in which columns 
are displayed in a list or a library. When you remove a column from the view, it hides 
the column but does not delete it or the data it contains. If you want to delete a 
column and the data within the column (versus just hiding the column from the view), 
you can permanently delete the column from a list or a library.

To create a new column in a list or a library
1.	 Go to the list or library where you want to create a new column.
2.	 On the List or Library tab, in the Manage Views group, select Create Column 

to open the Create Column page.
3.	 In the Name and Type section, in the Column name box, enter the name that 

you want for the column.

The Create Column page
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4.	 Under The type of information in this column is, select the type of informa-
tion that the new column will contain.

5.	 In the Additional Column Settings section, in the Description box, provide a 
description (this is optional).

TIP  Depending on the type of column you select, more options might appear in 
the Additional Column Settings section. Select additional settings as needed.

6.	 If the data in the column must be validated, select Column Validation to 
expand the Column Validation section.

TIP  If the Column Validation section is not available, the selected type of 
column does not allow validation.

The Column Validation section of the Create Column page

7.	 Provide the formula that you want to use to validate the data, and the user 
message that you want to display to the users to help them provide the valid data.

8.	 Select OK to create the new column and return to the list or library page.

To create a new column in the Quick Edit view

1.	 Go to a list or a library where you want to create a new column.

2.	 To switch to the Quick Edit view and display the list in a grid, do either of the 
following:

●● For a list, do one of the following:
●● At the top of the list, select edit.
●● Select List to open the ribbon, and then on the List tab, in the View 

Format group, select Quick Edit.

●● For a library, select Library to open the ribbon, and then on the Library tab, 
in the View Format group, select Quick Edit.
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3.	 In the list or library header row, at the top of the rightmost column (which is 
empty), select the plus sign (+) to display the menu of column types.

4.	 Select the type of information that the new column will contain.

The menu of column types in the Quick Edit view

The new column is created and is named after its type (for example, Number). 
The name is displayed highlighted and boxed, showing that you can rename 
the column.

5.	 If you want, position your cursor within the box and enter a new name for the 
column.

TIP  You can rename a column in Quick Edit at any time by selecting its name 
and then selecting Rename Column from the menu that appears.

To modify how the list and library columns are displayed

1.	 Go to a list or a library where you want to change columns.

2.	 On the List tab or Library tab, in the Manage Views group, select Modify View 
to go to the Edit View page.

3.	 In the Columns section, do either of the following:

●● To change whether a column is displayed in a list or a library page or hidden 
from view, under the Display heading to the left of the name of the column 
you want to change, select or clear the check box.
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The Columns section of the Edit View page

●● To change the order that a column appears on the list or library page, under 
the Position from Left heading for the column you want to change select 
the arrow to open the position number list, and then select the number 
that would show the new position of this column on the list or library page, 
counted from the left.

4.	 Repeat step 3 for all columns you want to modify, and then select OK to save 
your changes and return to the list or library page.

To permanently delete a column and its data from a list or a library

1.	 On the List Settings or Library Settings page for the list or library, display the 
Columns section.

2.	 Select the name of the column that you want to delete.

3.	 Scroll to the bottom of the Change Column page, and select Delete.

4.	 In the confirmation box, select OK.

TIP  Some columns in lists and libraries are required by SharePoint and can’t be deleted, 
such as Title or Name. If the column can’t be deleted, the Delete button is not available. 

If you can’t delete a column, but you don’t want the column to be displayed, you can hide it 
from view. 
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Sort and filter lists and libraries
As a list or library grows, it eventually becomes difficult to see the entire list or library 
on a single page. To this end, SharePoint provides built-in sorting and filtering capa-
bilities. On any standard list and library view page, individual column headings can be 
used to alphabetically sort the entire list in ascending or descending order.

TIP  Selecting another column heading abandons the sort on the current column. You 
must use Quick Edit view to sort on more than one column.

Filtering on list and library pages works much like an Excel AutoFilter works. Each 
column has a filtering arrow in its upper-right corner, which appears when you point 
to the column heading. When you select the arrow, a unique list of the values for each 
column is generated and presented as a drop-down list above that column.

TIP  In Quick Edit view, sorting and filtering are available by using the arrow also located 
in the upper-right corner of every column.

A list or library view is a selection of columns on a page that displays items in a list 
or library, and often defines a specific sort order, filter, grouping, and custom layout. 
Filters are cumulative but temporal; the next time a list view is chosen, its settings, 
including filters, will be applied to the list regardless of what was previously chosen. 
You can save the view that you have created by sorting and filtering a list or a library 
so that you can keep the sorting orders and filters and come back to it again.

To sort a list or a library

1.	 In a list or a library in which you want to sort the items, do one of the following:
●● Select the column name. If the column has not had a sorting order applied, 

selecting its name will sort it in ascending order. To change the sort order, 
select the column name again.

●● Point to the name of the column by which you want to sort, select the arrow 
to the right of the column name, and select the sort order.

The Sorting menu
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A thin arrow appears to the right of the column name, indicating that the list is 
sorted by this column. The arrow points up for ascending order, and down for 
descending order.

To filter a list or a library

1.	 In a list or a library in which you want to filter the items, point to the name of 
the column that contains the data you want to filter, select the arrow next to the 
name, and then, from the list of the values, select the items you want to display.

Filtering a column

2.	 When you are done, select Close.

TIP  To save your sort order and filters, you can create a list or a library view by using the 
Save This View option that appears in the upper-right corner of a list that has sorting or 

filtering applied. For more information about creating views, see Chapter 4, “Make lists and 
libraries work for you.”

To remove a filter from a list or library

1.	 Go to the list or library that you want to remove filtering from.

2.	 Locate the filtered column that you want to remove a filter from, point to the 
column heading, select the arrow at the right to display the filtering menu, and 
then select Clear Filters from Column Name.
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Delete and restore list items and 
documents
When documents, list items, folders, or even entire lists are deleted, they are simply 
flagged as removed so that they no longer appear in the site from which they were 
deleted. By default, all sites in SharePoint 2016 are configured to display deleted items 
in the site’s Recycle Bin for 30 days. The Recycle Bin provides a safety net when you 
are deleting documents, document sets, list items, lists, folders, and files. If the user 
hasn’t restored the deleted item in that time period, it is then permanently expunged 
from the database. If the user empties the Recycle Bin before the 30 days have 
elapsed, the deleted item is still available to a site collection administrator from the 
site collection’s Recycle Bin.

However, the total size of the deleted items must remain below a specified 
percentage (50 percent by default) of the total size that a site is allowed to consume 
(the site quota). If a newly deleted item causes the total to exceed the configured size 
allowed by the SharePoint central administrator, the items that were deleted first are 
purged even if 30 days have not elapsed, to make room for the newly deleted item. 
In this way, SharePoint administrators can make disaster recovery plans based on the 
Recycle Bin’s allowable total maximum size. Of course, a SharePoint administrator can 
configure the number of days that the Recycle Bin retains deleted items, ranging from 
the default 30 days in SharePoint 2016 to a specific setting for a number of days, or to 
“never retain deleted items” or “never remove deleted items.”

To delete a list or library item

1.	 Go to the list or library in which you want to delete an item.
2.	 Select the item you want to delete. You can select multiple items.
3.	 Do one of the following:

●● For a list item, do either of the following:
●● On the Items tab of the ribbon, in the Manage group, select Delete Items.
●● Select the ellipsis to the left of the item’s name, and in the callout that 

opens, select the ellipsis again, and then select Delete Item.
●● For a document, do either of the following:

●● On the Files tab of the ribbon, in the Manage group, select Delete 
Document.

●● Display the shortcut menu for the selected document, and select Delete.

4.	 In the confirmation dialog, select OK.
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To restore a list or library item

1.	 Go to the site that the list or library item was deleted from.

2.	 On the Quick Launch, select Recycle Bin to display the site Recycle Bin page.

3.	 Select the list item or document by selecting the check boxes at their left. You 
can select multiple list items and documents.

The Recycle Bin selection

4.	 At the top of the deleted items list, select Restore Selection to restore the 
selected items.

5.	 Select OK to confirm.

TIP  After you’ve restored the selection from the Recycle Bin, you might want to 
navigate to the original list or library to confirm that the list item or document has  

been restored to its original location. 

Stay up to date with content changes
In SharePoint 2016, you can stay up to date with content changes by using features 
such as the following:

■■ You can set up alerts to receive notifications via email or SMS when changes are 
made to the content of a site.

■■ You can follow documents to track updates to those documents in your 
newsfeed.
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Set up alerts
SharePoint 2016 includes a handy feature that sends an email notification or text 
message whenever changes are made to content in a site, including changes made 
to list items in a list. The setup for this notification is called an alert. You can set up an 
alert for a list, library, folder, file, or list item. No alerts are set up automatically, so you 
must subscribe to the alerts that you want. Alerts can be set up for different types of 
changes so that you can learn about the changes you are most interested in.

Alerts are quite easy to set up. Every list and library in a SharePoint 2016 site has an 
Alert Me button in the Share & Track group on the ribbon. You use the button on the 
List tab of the ribbon to subscribe to an alert on a list level, and the one on the Library 
tab to subscribe to an alert on a library level. To subscribe to an alert for an item or 
file, you select the item in a list or the file in a library, and then select the Alert Me 
button on the Items or Files tab, respectively.

TIP  For email alerts to be available, the SharePoint central administrator must configure 
the outgoing email settings for your server. Similarly, for text alerts to be available, the 

SharePoint Farm administrator must configure the SMS/MMS service settings. Both settings can 
be configured in SharePoint Central Administration. If these settings are not configured, the 
Alert Me button on the ribbon and the Alert Me option in the callout menu will not be 
available.

Alerts specify to whom the alert will be sent and the kind of changes and frequency 
for which the alert will be sent. By default, the alert is sent to the email address of the 
user who sets up the alert. If no email address has been established for the authenti-
cated user, an email prompt is generated in the Send Alerts To area. After it has been 
provided, the address will be remembered for subsequent subscriptions.

When you set up an alert, you choose the type of change for which the alert should 
be initiated. For example, list-level alerts have subscriptions for All Changes To Any 
List Item, New Items Are Added Only, Existing Items Are Modified Only, or Items Are 
Deleted Only. If you want to see added and changed items but not deleted items, you 
need to set up two alerts. List item–level alerts, however, are only sent when the item 
changes, because you can only set up this alert after the list item already exists, and a 
deletion is considered a change to the list item.

Chapter 3: Work with content in lists and libraries

92



3

You must specify when to send alerts; the default is when anything changes. Different 
lists and libraries have different options available. For example, a document library 
provides the following change alert options for a document:

■■ Anything Changes

■■ Someone Else Changes A Document

■■ Someone Else Changes A Document Created By Me

■■ Someone Else Changes A Document Last Modified By Me

You must also specify the alert frequency. There are three choices for any type of 
alert.

■■ Send Notification Immediately

■■ Send A Daily Summary

■■ Send A Weekly Summary

Choosing to receive an alert immediately actually queues the notice to be sent as 
soon as the next job runs after the alert is triggered. By default, the alert job runs 
every 5 minutes but could be configured by your administrator to wait as long as 59 
minutes. The daily and weekly summaries store all changes made to the list or list 
item and send a summary at the end of the period. By default, daily summary alerts 
are generated at midnight each night, and weekly summary alerts are generated at 
midnight every Sunday night.

To set up an alert for a list item or a document

1.	 Go to a list or a library that contains an item that you want to set up an alert for.

2.	 Select the item or document for which you want to set up an alert.

3.	 Do one of the following to open the New Alert dialog box:

●● For a list item, do either of the following:

●● On the Items tab of the ribbon, in the Manage group, select Alert Me, 
and then select Set alert on this item.

●● Select the ellipsis to the left of the item’s name, in the callout that opens, 
select the ellipsis again, select Advanced, and then select Alert me.
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●● For a document, on the Files tab, in the Share & Track group, select Alert 
Me, and then select Set alert on this document.

Setting up an alert on a document

4.	 In the New Alert dialog, provide the alert title, who the alerts should be sent 
to, and the delivery method. Select the criteria for the new alert and the alert 
frequency, and select OK.

Follow documents
In SharePoint 2016, you can follow documents to track updates to them in your 
newsfeed. Following a document is different from receiving alerts about the changes 
to the document; setting an alert for the document keeps you notified of specific 
changes at the predefined frequency, via an email or SMS, whereas following a docu-
ment adds a link to this document in your newsfeed and provides notifications of all 
document changes via your newsfeed. In addition, people who are following you will 
get a newsfeed notification that you’re following this document, if they have appro-
priate permissions to access it. All documents that you follow are shown in one place 
in your newsfeed, in the list of followed documents.
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To follow a document

1.	 Go to a library that contains the document you want to follow.

2.	 Do one of the following:

●● Display the shortcut menu for the document, select Advanced, and then 
select Follow.

●● Select the ellipsis to the left of the document’s name, and in the callout that 
opens, select Follow.

Notice the confirmation that is displayed for a short time in the upper-right 
corner of the page.

Confirmation that you are following the document

TIP  After you’ve set up document following, you might want to navigate to your 
newsfeed to confirm that the document has been added to the list of documents that 

you are following. 

Work offline
If you are a mobile device user, you know that it’s not always possible or convenient 
to connect to SharePoint every time you want to read or modify a document. In 
SharePoint 2016, you can work with your documents offline. You can synchronize, 
or sync, a SharePoint library to your device. This process creates a copy of the library 
on your device in the SharePoint folder, under the name that combines the name 
of the source SharePoint site with the name of the source library, with a hyphen in 
between—for example, Team Site-Documents. You can modify the location to one  
of your choosing. You can then work with files in the library by using File Explorer. 
When working offline, you can view and modify the content in the same way you 
can when working in SharePoint. Updates to the files synchronize back to SharePoint 
when you are back online. For example, if you create a new document in a library 
folder on your device, it will be synced back into the source library when you are 
online.

TIP  There are limits on the number and size of files you can sync. You can sync up to 
5,000 items in a library, including folders and files. You can download files up to 10 GB. 
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IMPORTANT  To use sync, you must have Office 2016 or Office 2013 installed on your 
device or have an Office 365 subscription that includes Office programs. 

To sync a library to your device

1.	 In SharePoint, go to a library that you want to sync to your device.

2.	 In the body of the page, above the list of documents, select Sync.

3.	 Confirm that you want to sync the library by selecting Sync now in the 
confirmation dialog.

Sync confirmation

4.	 If the browser security dialog box appears, select Allow.

5.	 In the message box that appears, select Sync Now to confirm the root location 
and start the sync.

6.	 A message appears confirming that the sync has started. The full path to the 
location is shown, including the root, the SharePoint folder, and the subfolder 
that is named after the site and the library, with a hyphen in between; for 
example, C:\Sharepoint\Team Site-Documents.

If you want to see the files as they come in, select Show my files.

Chapter 3: Work with content in lists and libraries
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Skills review
In this chapter, you learned how to:

■■ Discover lists and libraries in a site

■■ Create and populate lists

■■ Create and populate libraries

■■ Check files out and work with versions

■■ Organize lists and libraries

■■ Delete and restore list items and documents

■■ Stay up to date with content changes

■■ Work offline

Work offline
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Practice tasks
The practice files for these tasks are located in the SP2016SBS\Ch03 folder.

IMPORTANT  You must have sufficient permissions to perform the 
operations involved in each practice task to complete that practice task.  

For more information, see Appendix A, “SharePoint 2016 user permissions and 
permission levels.” 

Discover lists and libraries in a site
Go to your SharePoint site and sign in if prompted. Then perform the following tasks:

1.	 Go to the Your Apps page.

2.	 Using Search, filter the page to display only the list apps available on your site.

3.	 Using Search, filter the page to display only the library apps available on your site.

Create and populate lists
Continuing on your SharePoint site, perform the following tasks:

1.	 From the Your Apps page, create a Tasks list and name it BuyerTasks.

2.	 Change the display name of the BuyerTasks list to Common Buyer Tasks.

3.	 Go to the Common Buyer Tasks default list view page, and confirm the 
following:

●● The page title shows the modified list name.

●● The browser’s address bar reflects the original list name.

4.	 In the Common Buyer Tasks list, create a task named Create vendor 
SharePoint list.

5.	 Switch to the Quick Edit view of the list, and add the following tasks:

Task name	 Due date

Ensure vendor access	 Any date of your choosing

Identify products to purchase	 Any date of your choosing

Generate purchase order		  A date after the previous date

Notify Receiving about purchase	 A date after the previous date

6.	 Return to the default list view page of the Common Buyer Tasks list.

98

Chapter 3



7.	 Edit the Create vendor SharePoint list task to mark it as complete. Confirm that 
the completed task is now checked and crossed out.

8.	 Add the WideWorldPurchaseOrder document from the practice file folder to the 
Generate purchase order task, and then return to the default list view page.

9.	 To confirm that the document has been successfully attached, display the Gen-
erate purchase order list item’s page. Verify that WideWorldPurchaseOrder.
docx is shown in the Attachments field at the bottom of the list item page, and 
then return to the list.

Create and populate libraries
Continuing on your SharePoint site, perform the following tasks:

1.	 Create a library named Furniture.

2.	 Go to the Furniture library and do the following to upload documents from the 
practice file folder to the library:

●● From your browser, launch the Add a Document dialog and upload the 
OakDesk document from the practice file folder to the library.

●● Drag the OakChest document from the practice file folder to the library 
page in your browser.

●● Copy the OakNightStand and OakEndTable documents from the practice 
folder and paste them into the Explorer View of the library.

3.	 Refresh the library page in your browser and verify that the library contains the 
uploaded documents.

4.	 From within the library, create a new Word document, either in the Word client 
program or in Word Online. Enter the text Oak Mirror in the document, and 
then save the document back to the library with the name OakMirror.

5.	 Refresh the page and verify that the library contains the new document.

6.	 Open the OakMirror document for editing. Format the document text as bold 
and centered, and then save the document back to the library.

7.	 Refresh the library page in the browser and verify that the changes to the 
OakMirror document were saved by checking its timestamp.

8.	 Close the program you used to edit the OakMirror document if it’s still open, 
either the Word client program or Word Online.
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Check files out and work with versions
Continuing on your SharePoint site, perform the following tasks:

1.	 Go to the Furniture library.
2.	 Check out the OakChest document. Verify that the file icon indicates that the 

document has been checked out.

3.	 Check in the OakChest document, entering the comment This is the final 
version of the document in the Check in dialog box. Verify that the file icon 
indicates that the document is no longer checked out.

4.	 Display the Version History dialog for the OakChest document.

TIP  If the Version History option is unavailable, versioning is disabled for this 
document library. To enable versioning, on the Library tab of the ribbon, select 

Library Settings, and then on the Settings page, under General Settings, select 
Versioning Settings. On the Versioning Settings page, in the Document Version History 
section, select Create Major Versions, and then select OK. To continue with this set of 
tasks, go back to the Furniture library, check out the OakChest document, and then 
check it in to create a second version.

5.	 In the Version History dialog, review the versions saved for the OakChest 
document.

6.	 Restore the first version of the document, and then return to the library.

Organize lists and libraries
Continuing on your SharePoint site, perform the following tasks:

1.	 Go to the Furniture library.
2.	 In the library, create a folder named In Progress.

3.	 Modify the default list view of the Furniture library as follows:
●● Remove the Modified By column.
●● Display the Version column.

4.	 Save your changes and return to the library page. Confirm that the library 
columns are displayed as expected.

5.	 Sort the Furniture library documents in ascending alphabetical order by Name, 
and then reverse the sort order.

6.	 Go to the Common Buyer Tasks list, and switch to the Quick Edit view.

7.	 To the right of the existing columns, add a column of the type Number.

8.	 Rename the Number column to Sequence.
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9.	 In the Sequence column, enter the following numbers to identify the preferred 
order of tasks in the list:
Title	 Sequence
Create SharePoint list	 2
Ensure vendor access		  3
Identify products to purchase	 1

Generate purchase order		  5
Notify Receiving about purchase	 4

10.	 Modify the default list view of the Common Buyer Tasks list as follows:
●● Hide the Assigned To and Due Date columns.
●● Display the %Complete column.
●● Change the position of the Priority column to 3 so that it appears immedi-

ately to the left of the Task Name column in the list view page.
11.	 Save your changes and return to the list page. Confirm that the list columns are 

displayed as expected.
12.	 Sort the Common Buyer Tasks list in ascending numerical order by Sequence, 

and then reverse the sort order.
13.	 Switch to the Quick Edit view of the list. Change the Priority of the Ensure 

Vendor Access and Generate Purchase Order list items to (1) High, and then 
return to the default list view.

Changing priority of tasks

14.	 In the default list view, filter the list to display only the items that have a Priority 
of (1) High. Then remove the filter from the Priority column to display a full list.

Delete and restore list items and documents
Continuing on your SharePoint site, perform the following tasks:

1.	 Go to the Common Buyer Tasks list if it is not already open.
2.	 Delete the Create Vendor SharePoint list item.

3.	 Go to the Furniture library.

101

Practice tasks



4.	 Delete the OakChest document.
5.	 Go to the site Recycle Bin and restore the Create vendor SharePoint list item 

and the OakChest document.
6.	 Go to the Common Buyer Tasks list and verify that the list item has been 

restored.

7.	 Go to the Furniture library and verify that the OakChest document has been 
restored.

Stay up to date with content changes
Continuing on your SharePoint site, perform the following tasks:

1.	 Go to the Common Buyer Tasks list.

2.	 Set an alert on the Generate purchase orders task. Accept the default options.

3.	 Switch to the Quick Edit view of the list.

4.	 Change the Priority for the Generate purchase orders task to (2) Normal, and 
then switch back to the default list view.

5.	 Open your email program, and confirm that you have received an email alert 
notifying you of a change in priority in this list item.

6.	 Go to the Furniture library.

7.	 Select the Follow option for the OakDesk document.

8.	 On the top left of the page, select your Newsfeed page and verify that the 
OakDesk document is listed under Docs I’m following.

Work offline
Continuing on your SharePoint site, perform the following tasks:

1.	 Go to the Furniture library.

2.	 Start the library sync to your local device.

3.	 In File Explorer on your local device, go to the C:\SharePoint 
\Team Site-Furniture folder to confirm that the library has been synced.

TIP  Depending on your connection and the data volume, there might be a small delay 
before all the files are synced to your device and appear in the SharePoint folder.
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7Work with 
webpages

In this chapter
■■ Understand SharePoint pages

■■ Create pages

■■ Add content to pages

■■ Manage pages

■■ Use app parts and web parts

Practice files
For this chapter, use the practice files 
from the SP2016SBS\Ch07 folder. For 
practice file download instructions, 
see the introduction.

In previous chapters, you learned how to organize your 
content into site collections, sites, lists, and libraries; 
however, Microsoft SharePoint sites are similar to other 
websites in that they can contain multiple webpages. 
In fact, you could think of storing information in a file, 
such as a Microsoft Word document or a Microsoft Excel 
worksheet, as hiding that information. Before a user 
can see the information in such files, the file has to be 
downloaded to the user’s computer, and then a separate 
program or app has to be opened to display the contents 
of the file. With a webpage, your browser displays the 
information immediately when you select the link to the 
page. Therefore, it is just as important to place content 
on pages as it is to use lists and libraries.

This chapter guides you through procedures related 
to creating pages, adding content to pages, managing 
pages, and using app parts and web parts.
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Understand SharePoint pages
SharePoint Server includes four types of webpages. The ones you see and can create 
for a site depend on the site template used to create the site. These are:

■■ Wiki pages

■■ Web part pages

■■ Publishing pages

■■ Application pages

On team sites and community sites, the two types of pages you will work with are wiki 
pages and web part pages. Publishing pages are available on sites you create by using 
one of the publishing site templates, such as the Publishing Portal, Enterprise Wiki, 
Product Catalog, Publishing Site, Publishing Site with Workflow, or Enterprise Search 
Center site templates.

You can customize the first three types of pages by using the following tools:

■■ Your browser

■■ A SharePoint-compatible webpage-editing tool, such as Microsoft SharePoint 
Designer 2013

■■ A professional development tool, such as Microsoft Visual Studio

No one tool can do everything; therefore, it is likely that when you use SharePoint, 
either in an on-premises installation of SharePoint Server or SharePoint Online, your 
organization will use all three tools at some point.

Web part pages
Web part pages consist of web part zones that can contain app parts and web parts. 
Multiple web parts can be added to each zone. After a web part is added to a zone, 
you can alter the location of the web part within the zone, and you can move the web 
part from one zone to another. The web part zones are visible only when you are edit-
ing a page.

Chapter 7: Work with webpages
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TIP  Some zones allow web parts to be stacked in a horizontal direction, whereas others 
stack them in a vertical direction. The illustration in the Layout section of the New Web 

Part Page page displays the selected Layout template. If you do not add a web part to a zone, 
the zone collapses (unless it has a fixed width), and the other zones expand to fill the unused 
space when you go to the web part page. Therefore, if you currently believe you only need two 
zones, displayed as two columns, a good choice would be the Header, Footer, 4 Columns, Top 
Row layout template, because this layout allows for other layout combinations if you need them 
in the future. 

When you create a web part page, you can choose the layout of the zones.

IMPORTANT  You cannot change the zone layout after you create the web part page. 

Web parts are reusable components that can contain any type of web-based informa-
tion, including analytical, collaborative, and database information. App parts are used 
in conjunction with apps you add to your site from your organization’s app store or 
from the online SharePoint Store.

TIP  To include free-format static text or images on a web part page, you must use the 
Content Editor web part (CEWP) or the Image Viewer web part. 

App parts can also be used to display content from lists and libraries, so the content 
dynamically changes as you upload, modify, and delete list items in the lists or files in 
the libraries. These app parts are used on the web part pages that are created when 
you create views in your lists and libraries.

Understand SharePoint pages
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TIP  Web part pages can be configured to send data from one web part or app part to 
another by using a mechanism called a web part connection. This allows you to create 

interactive pages. 

There are a couple of disadvantages of using web part pages: many users find the 
mechanism of changing such pages not intuitive, and after you create a web part 
page with a specific layout of web part zones, you cannot change the layout.

Web part pages are the default pages on sites that are created from the Project, 
Document Center, Record Center, Community Portal, and Compliance Policy Center 
site templates. On these sites, you need the Add And Customize Pages permission to 
edit the default web part page. If you do want to create multiple pages on these sites, 
you can create a wiki page library where you can create wiki and web part pages.

Wiki pages
Wiki pages are easy to use and their layout is easy to change. When you edit the 
home page of a team site, you’ll see that it consists of three content areas, each con-
taining a web part or an app part:

■■ Get Started With Your Site  This web part displays five tiles that you can select 
to quickly complete common SharePoint actions. As you point to each tile, a 
description of the task is displayed. You can remove this web part by selecting 
Remove This.

■■ Site Feed  This web part displays a newsfeed on your site; its use is also 
known as microblogging. These microblogging conversations are stored in the 
MicroFeed list.

■■ Documents  This app part displays the contents of the Documents library.
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In the content areas, you can add static text, app parts, and web parts

When you create a team site or community site, SharePoint creates a wiki page library 
named Site Pages, where webpages are stored and where new pages can be created. 
The Site Pages wiki library inherits its permissions from the site. Therefore, anyone 
who is mapped to the Edit permission level at the site level—that is, anyone who is a 
member of the site’s Members SharePoint group—is allowed to change any page or 
create new pages in the Site Pages library. This is known as open editing. Any member 
of the site can edit it as he or she wants if, for example, the member thinks the page 
is incomplete or poorly organized. Therefore, as users share their information, knowl-
edge, experience, ideas, and views, the content evolves. Site members can work 
together to change or update information without needing to send emails or attend 
meetings or conference calls. All users are allowed to control and check the content, 
because open editing relies on the assumption that most members of a collaboration 
site have good intentions.

Wiki pages can also contain app parts and web parts. Although you cannot use web 
part connections on wiki pages, the ease with which you can mix free-format static 
text and images on wiki pages in addition to web parts and app parts make them a 
popular page choice on team sites.

Understand SharePoint pages
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TIP  Wiki page libraries can be created on any site where the Team Collaboration Lists 
site feature has been activated. There is a second type of wiki page that you can create 

when you create a site collection based on the Enterprise Wiki site template. This wiki page is a 
type of publishing page. For more information about Enterprise Wiki sites, see Chapter 9, 
“Work with wikis, blogs, and community sites.” 

Publishing pages
For Internet sites and company portals, when the content on a page is to be viewed 
by a large number of people, pages might need to go through a formal approval pro-
cess before users can view them. In such cases, publishing sites and publishing pages 
are a better choice than team sites and wiki pages. Most visitors to a publishing site 
want to consume information displayed on the page. They will not be allowed to edit 
the pages. Only a few users will be able to create, edit, and delete publishing pages.

Publishing pages, also known as Web Content Management (WCM) pages, are stored 
in the Pages library and are created from publishing templates known as page lay-
outs. After you create a publishing page, you can change the layout of the page by 
choosing a different layout.

Publishing pages can have both content areas and web part zones. Content areas on  
a publishing page can be similar to the content areas that you use on a wiki page in 
that they can contain text, images, app parts, and web parts. However, some content 
areas can be very restrictive—for example, they might allow you to insert only an 
image or plain text. The name of the content area usually indicates the type of con-
tent you can add. The content area names and the web part zone names are displayed 
only when you are editing the page. The layout and the type of content you can add 
to the content areas is dependent on the layout chosen for the publishing page.

Content areas with a grey background are displayed only when you edit the page
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Application pages
Application pages, also known as system pages, look very similar no matter which site 
you go to. Examples of such pages are the List Settings page and the Site Settings page. 
These pages contain _layouts in their URLs, as in intranet.wideworldimporters.com 
/_layouts/15/viewlsts.aspx, which is the web address for the Site Content page on the 
Wide World Importers intranet site.

TIP  Application pages cannot be created, modified, or managed by using your browser 
or SharePoint Designer, so they are not covered in the following topics.

Create pages
The first page displayed on a SharePoint site is known as the home page. This is the 
page on which all site visitors start. In your organization, the home page might be 
known as the default page, the welcome page, or the landing page. Home pages 
tend to aggregate information from elsewhere and direct users to other pages. For 
instance, in the Quick Launch for a home page, when you select Documents, you are 
taken to the default view of the Documents library.

There are many reasons why adding content to just the home page is not enough. 
Although you can add a vast amount of content on one page, this can result in the 
page taking a long time to render, and it can be difficult for users to find content if 
they have to scroll down the page many times. Try to compose your content into mul-
tiple pages, each with no more than two or three screens of information; and never 
add content to a page so that users have to scroll to the right to see the content. Link 
your pages together so that users can navigate easily between them in an organized 
manner.

There are several methods for creating a new page; however, the recommended 
method for creating pages that contain content that relates to content on existing 
pages is to create a forward link, also known as a wiki link, by entering the name of the 
page within two sets of double square brackets. This is quicker and easier than using 
the Links command on the Insert tab.

TIP  If you want to enter double open or closed square brackets in the content of a page 
without making a link, enter a backslash before the two brackets, as in \[[ or \]].

Create pages
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To create a wiki page

1.	 Go to the team site where you want to create a new wiki page, and then, on the 
Settings menu, select Add a page.

Use the Setting menu to create or edit pages

2.	 In the Add a page dialog, enter the name of your new page.

Enter the name of your page

TIP  The name of the page will appear at the top of the page and is also used to 
create the web address (URL) of the page.

3.	 Select Create.

Or
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1.	 On the home page of your team site or community site, go to the Page tab and 
then, in the Page Library group, select View All Pages to display the default 
view of the Site Pages library.

Use the Page tab to manage pages

2.	 Do one of the following to display the New Item page:

●● Below the title for the Site Pages library, select New.

Use the New command below the title of the Site Pages library to create a new page

●● On the Files tab, select New Document.

3.	 Enter the name of the page, and then select Create.

On the New Item page, enter the name of the new page

To create a web part page

1.	 On the home page of your team site or community site, go to the Page tab and 
then, in the Page Library group, select View All Pages to display the default 
view of the Site Pages library.

2.	 On the Files tab, select the New Document arrow (not the button), and then 
select Web Part Page.

Create pages
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Use the New Document menu to create either a wiki page or a web part page

3.	 On the New Web Part Page page, in the Name box, enter the name of your 
page, and then in the Layout section, select the layout template that has the 
web part zone arrangement you want.

Use the New Web Part Page page to choose a name and zone layout for your webpage

4.	 In the Save Location section, in the Document Library list, select Site Pages.
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TIP  Although you can save web part pages in any library, if you want to create 
wiki links from your wiki pages to a web part page, your web part page must be 

stored in the Site Pages library.

5.	 Select Create.

To create a publishing page

1.	 Go to the publishing site where you want to create the publishing page and 
then, on the Settings menu, select Add a page.

2.	 In the Add a page dialog, enter the name of your new page, and then select 
Create.

Or

1.	 Go to the home page of your publishing site.

2.	 If no tabs are displayed, on the Settings menu, select Show Ribbon.

3.	 Go to the Page tab, and then, in the Edit group, select New.

Use the Page tab to create, edit, and manage your page

4.	 In the Add a page dialog, enter the name of your new page, and then select 
Create.

Or

1.	 Go to the home page of your publishing site.

2.	 Go to the Page tab, and then, in the Page Library group, select View All Pages 
to display the default view of the Pages library.

3.	 On the Files tab, select New Document to display the Create Page page.

4.	 In the Title box, enter the name of the new page that you want to display to 
users.

5.	 In the Description box, enter the purpose of the page, including any search 
keywords that people can use to find the page.

Create pages
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6.	 Select the URL Name box. The name you entered in the Title box appears, with 
spaces replaced with hyphens.

7.	 In the Page Layout section, select the layout you want to use to control how the 
content on the page will be displayed.

Use the Create Page page to enter a URL name, title, description, and page layout for the page

8.	 Select Check Spelling.

9.	 Correct any spelling mistakes, and then select OK to close the Spell Checker 
dialog.

10.	 Select Create.

To create a wiki page or publishing page that is displayed by selecting a forward link

1.	 On the page where you want to add the forward link, activate edit mode.

2.	 Positon the cursor where you want to add the link to the page you will create.

3.	 Enter [[name of page|words that you want to display on the page for the link]]. 
An example is [[BedroomFurniture|exotic bedroom furniture]].

Creating a forward link to a page
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TIP  As you enter the name for the new page, a list of existing pages is displayed. 
You could select a name from this list to create a forward link to a page you 

previously created.

4.	 Save the page. The forward link is indicated by a dotted underline.

A forward link to a page that has not been created is denoted by a dotted underline

5.	 Select the underlined text to open the Add A Page dialog.

Creating a page from the Add A Page dialog

6.	 Select Create.

Add content to pages
After a page has been created, you can add content, such as text, tables, images, and 
links to other pages or websites. When you have finished entering your content, save 
the page. You can re-edit any page at a later time as necessary.

TIP  The only way to add content to web part pages is by adding app parts or web parts. 
This is covered in the “Use app parts and web parts” topic later in this chapter.

Modify pages
To prevent two people from editing a page at the same time, anyone intending to 
modify content should always check out the page before he or she begins. When you 
edit a publishing page, the page is automatically checked out to you. You must check 
out wiki pages and web part pages yourself.

Add content to pages
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TIP  When another member of your team has checked out a page, the Check Out 
command on the Page tab is inactive, and a yellow notification area is displayed at the 

top of the page, stating who the page is checked out to.

The Pages library, where publishing pages are stored, is configured for major and 
minor (draft) versions. Only users who can edit items can see the draft items; there-
fore, after you have checked in a page, the page must be published as a major version 
before visitors to the site can see the amendments you have made to the page.

SEE ALSO  For more information about checking in, checking out, and versioning, see 
Chapter 3, “Work with content in lists and libraries.”

As you modify a page, you might find that the layout you originally chose does not 
now suit the content you want to display. On both wiki pages and publishing pages, 
you can change the page layout.

To activate a wiki or publishing page for editing

1.	 Go to the page that you want to edit, and then do one of the following:

●● On the Settings menu, select Edit page.

●● In the upper-right corner of the page, select Edit.

Use the links in the upper-right corner to share a site, follow a site, edit a page, or focus on 
content

●● On the Page tab, select Edit.

Use the Page tab to edit and check out a page

TIP  On publishing pages, if the Page tab is not displayed, on the Settings 
menu, select Show Ribbon.
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To check out a wiki page

1.	 On the wiki page, on the Page tab, select Check Out. A yellow notification area 
is displayed at the top of the page, stating that the page is checked out and 
editable.

The yellow notification area at the top of a page is used to display the page status

TIP  If you are already editing a wiki page, you can also select Check Out on the 
Format Text tab.

To check in a wiki page

1.	 On the wiki page, on either the Page tab or the Format Text tab, do one of the 
following:

●● If you have the page checked out, to check in your changes, select Check In.

●● If you have the page checked out, to discard any changes you have made 
to your checked out version and release the checkout, select the Check In 
arrow, and then select Discard Check Out.

●● If the page is currently checked out to another user and you have the 
Override List Behaviors permission, which allows you to check in the page 
and discard any changes that user might have made to the checked-out 
version, select Override Check Out.

Use the Check In menu to check out, check in, discard a checkout, or override a checkout

Add content to pages
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To check in and publish a publishing page

1.	 On the publishing page, do one of the following:

●● In the yellow notification message, select Check it in.

The yellow notification area displays the status of the page and allows you to check in the page

●● Use one of the options described in the previous procedure, “To check in a 
wiki page.”

2.	 In the Check In dialog, enter a comment, and then select Continue.

3.	 Do one of the following:

●● In the yellow notification message, select Publish this draft.

●● On the Publish tab, select Publish.

To save or discard your modifications to a wiki or publishing page

1.	 After you have added content to a page, do one of the following:

●● To the right of the tabs, select Save.

When you edit a page, the upper-right Edit link is replaced with Save

●● If you are done adding content to the page, on the Page tab or the Format 
Text tab, select Save.

●● If you want to save the content you have added so far but intend to con-
tinue adding content to the page, on the Page tab or the Format Text tab, 
select the Save arrow and then select Save and Keep Editing.
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Use the Save split button to save, keep editing, or discard your modifications

●● On the Page tab or the Format Text tab, select the Save arrow, and then 
select Stop Editing. You will then be prompted to save or discard the 
content you have added to the page. To discard your modification, select 
Discard changes.

Use the Save Changes dialog to save or discard the changes you have made to a page, or select 
Cancel to return to editing the page

Format and display content
SharePoint provides you with a What You See Is What You Get (WYSIWYG) environ-
ment for adding content to your pages. When a wiki page or publishing page is in 
edit mode and the cursor is within the body of the page, two tabs are displayed: 
Format Text and Insert.

TIP  The Format Text and Insert tabs also appear when you enter content by using the 
Content Editor web part on a web part page.
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The commands on these tabs are similar to the commands on the Home and Insert 
tabs in Word: you use them to format the text, check spelling, and control the layout 
of the page, and to insert tables, images, videos, audio, hyperlinks, app parts, web 
parts, and embedded code.

You can also use keyboard shortcuts similar to those in other Office programs. If a tab 
command has a keyboard shortcut, you can display it by pointing to the command on 
the tab to display the screen tip.

Screen tips can include the command name, keyboard shortcut, and a description

The Format Text tab
The Format Text tab contains ribbon groups you will not find on the Home tab in 
Word. These include:

■■ Layout  This group appears on the Format Text tab only for wiki pages. Use 
the Text Layout command to create additional editing areas and to change 
the structure of your page. You can reformat the page by using any of eight 
options. For publishing pages, the Layout group is on the Page tab. Developers 
can create additional publishing page layouts, but no additional wiki page lay-
outs can be added to SharePoint.

You can control the layout of a wiki page
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■■ Markup  This group provides four commands:

●● Edit Source  Selecting this command opens a dialog that contains a plain-
text box in which you can enter HTML code. The text box displays the HTML 
tags for the content area where the cursor was located before you selected 
Edit Source. For example, if your wiki page has a two-column layout and the 
cursor is in the left column when you select the command, only the HTML 
for the left column is displayed in the dialog. You will need to know HTML to 
use this method of entering content on your page, because no IntelliSense 
help is provided; therefore, you might find it easier to use an HTML editing 
tool to create the content, and then paste it into the text box. To prevent 
the entry of malicious code, SharePoint does sanitize user-entered HTML 
content, so you might find that some of the code you enter is removed 
when you save the page.

●● Languages  When you create a SharePoint site, it has a default language. 
When you enter text in a different language, you can select the text and 
use this command to tag the language of the text. The SharePoint search 
functionality can then identify pages that include text in specific languages; 
some screen reader programs, such as the Job Access With Speech (JAWS) 
screen reader, use this so they can pronounce words correctly when they 
read them aloud.

●● Select  Use this command to select the HTML tag you want to work with. 
For example, to edit the HTML for a row in a table, place the cursor in a cell 
in the row, and then select the Select command to display the list of HTML 
tags that apply to that row, including the row itself and any parent HTML 
tags, such as for the table or the entire content area. A red dotted line sur-
rounds the area related to the HTML tag when you point to each tag in the 
Select list. To format or style the row, select the HTML for just the row.

●● Convert to XHTML  Most SharePoint pages adhere to and generate HTML 
to the XHTML 1.0 Strict specification; however, when you use the Edit Source 
command to create HTML, you might introduce errors into the page. By 
using this command, you might be able to fix those errors.
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The Insert tab
The Insert tab also contains ribbon groups you will not find on the Insert tab in Word. 
These include:

■■ Media  This group contains two split buttons:

●● Picture  Use this command to insert a picture from your computer, to refer-
ence a web address where a picture is stored, or to reference an image that 
is stored in a SharePoint library.

Use the Picture split button to insert a picture on the page

Use the first option, From Computer, when you have stored your image on 
the hard drive of your computer—for example, drive C. The default location 
to store images that you use on pages is the Site Assets library; however, 
you can choose a different library on the site.

TIP  The Site Assets library is the place to store files that are needed to brand 
a site, such as the image files used to display pictures on pages or files that 

contain team or company information. These are usually not files that team 
members will collaborate on, so they should be saved in the Site Assets library 
rather than in, for example, a document library.

Selecting the second option, From Address, opens the Select Picture dialog, 
in which you must manually enter or paste the URL of the image. To avoid 
incorrectly entering the URL for the image, which would result in a broken 
link, open another browser window or tab, navigate to the picture, copy 
the URL, and then paste the URL into the Address box in the Select Picture 
dialog.
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Selecting the From SharePoint option opens the Select An Asset dialog, 
which you use to navigate to a SharePoint library where you have previously 
uploaded an image.

●● Video and Audio  Use this split button to display video and audio on your 
page. This command provides the same three options as the Picture split 
button, plus a fourth option, Embed. Using the Embed option is the same as 
using the Embed Code option in the Embed group on the Insert tab, which 
is described later in this section.

■■ Content  This group appears on the Insert tab only on publishing pages and is 
detailed in the “Reusable content” section later in this topic.

■■ Parts  This group contains two commands, App Part and Web Part. The inser-
tion and configuration of these two components is detailed in “Use app parts 
and web parts” later in this chapter.

■■ Embed  This group contains the Embed Code option, which you can use to 
embed HTML code to display content not stored in SharePoint, such as content 
from Bing Maps, Vimeo, and YouTube. Most of these sources provide methods 
of generating the HTML code you need to embed in your page.

You can also use this option to display the contents of Word, Excel, or 
PowerPoint files, when Office Online Server (OOS) is installed in your organiza-
tion. OOS is a separate product from SharePoint; organizations can use it to 
deliver browser-based versions of Word, PowerPoint, Excel, and OneNote files, 
among other capabilities.

SEE ALSO  For more information about embedding Office documents and PDF 
files on a website, see “Embed Office documents and PDF files on a website” at 

https://aka.ms/Yx8n5e. For information about embedding an Excel workbook on a 
webpage, see “Embed your Excel workbook on your web page or blog from SharePoint 
or OneDrive for Business” at https://aka.ms/K4c5l6.

The embedded code is stored in an HTML iFrame tag, which means that your 
browser can display content stored in SharePoint immediately and it will display 
the content from the external source when it receives it. If the network connec-
tion to the external source is poor or the external source is not responding, you 
might have unexpected results. For example, if your source is a video source, 
you could end up with a blank video area on the page, or video buffering or 
playback problems. When this occurs, it is important to recognize that it is not a 
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SharePoint issue; you must investigate the network connection and the avail-
ability of the external source.

IMPORTANT  The insertion of an iFrame on a page could be seen as a potential 
scripting security risk. A site collection administrator can prevent users from 

using these commands by selecting HTML Field Security in the Site Collection 
Administration section on the Site Settings page.

Contextual tabs
When a component has been inserted onto a page and is selected, additional con-
textual tabs might be displayed. For example, if an image on a page is selected, the 
Image contextual tab is displayed. You can use the commands on the Image tab to 
replace the image, enter alternative text, format the borders of the image, position 
the image on the page, and reduce the area on the page used to display the image.

IMPORTANT  The commands in the Size group of the Image tab do not alter the file 
size of the image; they only place width and height attributes on the <img> HTML tag. 

Your browser uses these attributes to display the image. For prototyping purposes, this might 
be adequate; however, the image file could potentially use a large amount of network band-
width when it is downloaded from SharePoint to your computer, even if the browser then 
displays the picture at a smaller size than the file’s original size. So if you notice that a page 
takes more time to load than other pages, you might need to look at the size of the image files.

On publishing sites, you need not optimize your images before uploading them 
into SharePoint, because such sites can use image renditions, as long as your server 
administrator has configured their use. An image rendition is an optimized, scaled 
variant generated from the original image. By default, there are four rendition display 
templates; therefore, after you upload an image, you have the choice of five image 
sizes on your page: the original size of the image, and a rendition for each display 
template. You can change the renditions that SharePoint has generated, and if you are 
a site owner, you can add new rendition display templates.

On a publishing site, on the Image tab, use the Pick Rendition menu to select the image size for an image on 
your page and to edit the image renditions
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To format text on a page

1.	 On the page whose content you want to format, activate edit mode.

2.	 On the Format tab, use the commands to format the content as you want.

TIP  The commands in the Edit, Clipboard, Font, Paragraph, and Styles groups 
work the same as in any other Office program.

3.	 Save or save and publish the page.

To change the layout of a wiki page or a publishing page

1.	 On the page whose layout you want to change, activate edit mode.

2.	 Do one of the following to display a list of page layouts:

●● If the page is a wiki page, on the Format Text tab, in the Layout group, 
select Text Layout.

●● If the page is a publishing page, on the Page tab, in the Page Action group, 
select Page Layout.

3.	 Select a layout.

4.	 Save or save and publish the page.

To insert a picture, video, or audio

1.	 On the page where you want to display the picture, video, or audio, activate 
edit mode and position the cursor where you want to add the image or file.

2.	 On the Insert tab, select the Picture button, and then do one of the following:

●● If the file is on your computer, select From Computer to open the Upload 
Image dialog, select Browse, navigate to the location on your computer 
where the file is stored, and select Open. In the Destination list, select the 
library where you want to upload the file, and then select OK.

●● If the file is on the web, select From Address to open the Select Picture 
dialog. Enter the web address for the file you want to use, enter alternative 
text for the file, and then select OK.

●● If the file is already in SharePoint on your site, select From SharePoint to 
open the Select an Asset dialog, navigate to the folder or library where the 
file is stored, select the file, and select Insert.

Or
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On the Insert tab, select the Video and Audio button, and then do one of the 
following:

●● If the file is on your computer, select From Computer to open the Upload 
Media dialog, select Browse, navigate to the location on your computer 
where the file is stored, and select Open. In the Destination list, select the 
library where you want to upload the file, and then select OK.

●● If the file is on the web, select From Address to open the Link Media dialog. 
Enter the web address for the file you want to use, and then select OK.

●● If the file is already in SharePoint on your site, select From SharePoint to 
open the Select An Asset dialog, navigate to the folder or library where the 
file is stored, select the file, and select Insert.

3.	 Save or save and publish the page.

To format a picture, video, or audio on a page

1.	 On the page where you want format a picture, video, or audio, activate edit 
mode.

2.	 On the Image or Media tab, use the commands to format as you want.

3.	 Save or save and publish the page.

To insert and edit HTML markup

1.	 On the page where you want to insert and edit web-related code—for example, 
if you want to insert new HTML tags or modify the properties of the HTML tags—
activate edit mode.

2.	 Do one of the following:

●● To amend code that was generated by using the Format or Insert tab, place 
the cursor in the content area where the content is displayed, and then on 
the Format Text tab, in the Markup group, select Edit Source. Amend or 
enter the code, and then select OK.

●● To insert new code that is not directly related to content you inserted by 
using the Format or Insert tab, such as JavaScript or HTML code snippets, 
on the Insert tab, in the Embed group, select Embed. Enter the code, and 
select Insert.

3.	 Save or save and publish the page.
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To embed code from another source into a page

1.	 Navigate to the source of the content (for example, a Bing Map or a YouTube 
video), and use the source site’s tools to generate the code you want to embed.

2.	 Copy the code to the clipboard.

3.	 Go to the SharePoint page on which you want to display the content, and acti-
vate edit mode.

4.	 On the Insert tab, do one of the following to open the Embed dialog:

●● Select the Video and Audio arrow, and select Embed.

●● In the Embed group, select Embed Code.

5.	 In the text area of the Embed dialog, paste the code from the clipboard, and 
then select Insert.

6.	 Save or save and publish the page.

Reusable content
On publishing pages, the Insert tab has an extra command, Reusable Content, that 
you can use to add predefined content to your page—for example, a copyright, a 
byline, or a quote, such as your company’s mission statement. Reusable content is 
stored in the Reusable Content list at the top-level site of a site collection and can 
consist of blocks of plain text and HTML elements, such as formatted text, images, 
tables, and lists. You can use this functionality to create content once, and then allow 
users who edit pages to reuse these pieces of content.

In the Reusable Content list, you can create categories and folders to help you 
organize the reusable content items. The items can be designated as automatically 
updated or not:

■■ Automatically updated items  The reusable content is inserted into the page 
as a read-only reference. When the item is changed in the Reusable Content 
list, the page content is changed.

■■ Not automatically updated items  The reusable content is copied in the page. 
The page is not updated if the reusable content item is updated in the list.

IMPORTANT  You must have Contributor permission to add items to the Reusable 
Content list. To add a reusable content item to your publishing page, you must have 

read permission to the Reusable Content list. To add or modify a category or folder in the 
Reusable Content list, you must have the Manage Lists permission. 
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To create a reusable content category

1.	 Navigate to the top-level site of your site collection, and then on the Settings 
menu, select Site contents to display the Site Contents page.

2.	 Select Reusable Content to display the default view of the Reusable Content list.

3.	 On the List tab, in the Settings group, select List Settings.

4.	 Under Columns, select Content Category.

5.	 On the Edit Column page, under Type each choice on a separate line, enter a 
name for your new category.

6.	 At the bottom of the page, select OK.

To create a reusable content item

1.	 On the Site Contents page, select Reusable Content.

2.	 Do one of the following:

●● Select new item to create a new reusable HTML item.

●● On the Items tab, select the New Item arrow, and then do one of the 
following:

●● To insert plain text, select Reusable Text.

●● To insert another type of content, such as rich text or an image, select 
Reusable HTML.

3.	 Do the following:

a.	 In the Title box, enter the title of the reusable content item.

b.	 In the Content Category list, select a category.

c.	 If you want the item to be inserted in a page as a read-only reference, select 
Automatic Update; otherwise, leave this check box cleared.

d.	 Enter the reusable content.

e.	 If you chose to create a reusable HTML item, format the text and insert 
HTML elements.
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Use reusable content for content that you find you have to create again and again

4.	 Select Save.

To use a reusable content item on a publishing page

1.	 On the publishing page where you want to use the reusable content, activate 
edit mode.

2.	 On the Insert tab, select Reusable Content, and then select the reusable content 
item you want to add to the page.
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Manage pages
After you have created several pages, you might need to perform other tasks with them, 
such as changing the page that is your site’s home page, deleting pages, restoring deleted 
pages, or reviewing the popularity trends of your pages. You can also use alerts to receive 
email messages whenever a page is changed.

TIP  Like deleted documents and deleted list items, deleted pages are sent to the 
Recycle Bin. For more information about the Recycle Bin and about using alerts, see 

Chapter 3, “Work with content in lists and libraries.”

Both the Site Pages and Pages libraries have all the features of document libraries, 
such as history and version management, so the risk of losing your page changes is 
low. Major versioning is turned on by default for the Site Pages library, and major and 
minor versioning for the Pages library. You can also use content approval and work-
flow, and you can restrict the permissions regarding who can edit and publish pages.

SEE ALSO  For more information about content approval, see Chapter 4, “Make lists and 
libraries work for you.” For more information about workflow, see Chapter 11, “Work with 

workflows.” 

To view all pages in either the Pages or Site Pages library

1.	 Do one of the following:

●● Go to a page, and then, on the Page tab, in the Page Library group, select 
View All Pages.

●● From the Site Contents page, select Pages or Site Pages.

To make a page the home page for a site

1.	 Go to the page you want to make the home page.

2.	 On the Page tab, in the Page Actions group, select Make Homepage.

To display a page’s history

1.	 Go to the page, and then on the Page tab, in the Manage group, select Page 
History.
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The page history displays static content; additions are displayed in a green font and deletions in 
a red strikethrough font

To compare two versions of a page

1.	 Display the page history of the page as described in the previous procedure.

2.	 In the left navigation pane, below one of the versions you want to use in the 
comparison, in the Compare with version list, select a prior version number.

Display what has been added and deleted between one version of the page and another

To revert to a previous version of a page

1.	 Do one of the following to display the page’s version history:

●● Display the page history of the page as described in the “To display a page’s 
history” procedure earlier in this topic, and then select Version History.

●● Display all pages as described in the “To view all pages in either the Pages or 
Site Pages library” procedure earlier in this topic, select the page you want 
to revert, and then on the Files tab, in the Manage group, select Version 
History.
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2.	 Select the date and time in the Modified column for the version you want to 
restore as the current version, and then select Restore.

Use the menu to view, restore, or delete a version of a page

3.	 Select OK to confirm that you want to replace the current version of the page 
with the selected version of the page.

4.	 Go to the page and, in the yellow notification message, select Revert to 
template.

The yellow notification message states that the page has been customized from its template

5.	 Select OK. The yellow notification message disappears.

To delete a page

1.	 Do one of the following:

●● Go to the page you want to delete. On the Page tab, in the Manage group, 
select Delete page, and then select OK to confirm that you want to send 
the page to the site Recycle Bin.

●● Display all pages as described in the “To view all pages in either the Pages 
or Site Pages library” procedure earlier in this topic, and then do one of the 
following:

●● Right-click the page, and then select Delete.

●● Select the page, and then on the Files tab, in the Manage group, select 
Delete Document.

TIP  You cannot delete the home page of a site. 
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To restore a deleted page

1.	 Do one of the following to display the Recycle Bin:

●● On the Quick Launch, select Recycle Bin.

●● On the Site Settings menu, select Site Content, and then select Recycle Bin.

2.	 Select the page you want to restore, and then select Restore Selection.

3.	 Select OK to confirm that you want to restore the page.

To create an alert on a page

1.	 Go to the page for which you want to set up an alert.

2.	 On the Page tab, in the Share & Track group, select Alert Me, and then in the 
list, select Set an alert on this page.

3.	 In the New Alert dialog, select your preferences so that you receive an email 
based on your specific criteria and frequency, and then select OK.

Use app parts and web parts
As you customize your site, you might decide to add information other than static text 
and images. This information might be stored in lists or libraries or in some other data 
source. You add such content by using app parts and web parts. You can insert both 
app parts and web parts on multiple pages, and you can also insert them multiple 
times on the same webpage.

SharePoint provides built-in app parts and web parts, as detailed in the following 
table. The category specified in the table is the category name that is displayed when 
you use the app parts pane. The availability of an app part or web part depends on 
the type of site you are working with.

Category Description

Apps This category contains app parts, which display app information. 
SharePoint apps are similar to the apps you might find on Facebook or on 
your smartphone. App parts can also be used to display the contents of 
list and library apps; each time data in the list or library app changes, the 
changes are reflected in the app part.

Blog Use these web parts to help you display and manage blog posts.
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Category Description

Business Data This category contains web parts related to Business Connectivity 
Services (BCS) and Microsoft Excel, Visio, and Access.

Community These web parts are available on community sites. For more information 
about community sites, see Chapter 9, “Work with wikis, blogs, and 
community sites.”

Content Rollup These web parts can be used to display content from the current site and 
from other sites. They include the Content Query, Content Search, and 
Project Summary web parts.

Document Sets These web parts can be used to display the contents and properties of 
document sets. For more information about document sets, see Chapter 14, 
“Manage and monitor content.”

Filters These web parts can be used to filter the contents displayed by other web 
parts on the page.

Forms The web parts in this category can display content from HTML or 
Microsoft InfoPath forms.

Media and 
Content

Use these web parts to add content to the page. They include the Content 
Editor, Script Editor, Image Viewer, and Get Started With Your Site web 
parts.

Search These web parts are used with the SharePoint search functionality and on 
the Search site to display search results and refinements.

Search-Driven 
Content

These web parts can be used to display the results of a search query.

Social 
Collaboration

Use these web parts to display socially related content, such as newsfeeds, 
contact details, and user tasks.

SQL Server 
Reporting

The web part in this category is used with Microsoft SQL Server Reporting 
Services.

Miscellaneous Only one web part is listed in this category: the Case Content web part 
that is used in the eDiscovery Center.

TIP  In addition to built-in web parts, you can create your own web parts by using tools 
such as Visual Studio. You can also import custom web parts. 

All app parts and web parts have a set of common properties that you can use to con-
trol the part’s appearance and behavior, such as toolbar type, chrome type, the part’s 
height and width, and whether users can minimize it so that only the title is visible. 
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You can configure the common properties by using either the web part tab or the 
Appearance, Layout, or Advanced section of the web part tool pane.

Each app part and web part can also have a set of custom properties. These proper-
ties might be displayed on a separate contextual tab, or they might be in the web 
part tool pane, in their own section, or in the Miscellaneous section. For example, 
if you insert an app part on your page that displays the contents of a list, when you 
select the check box next to the app part title (in edit mode), three tabs appear on the 
ribbon: Files, Library, and Web Part.

TIP  If you are having persistent problems with an app part or web part or a web part 
connection, you can use the Web Part Maintenance page to delete the app part or  

web part. You can navigate to the Web Part Maintenance page by appending ?Contents=1  
to the page’s URL; for example, intranet.wideworldimporters.com/sites/Sales/SitePages 
/Home.aspx?contents=1.

To activate a web part page for editing

1.	 Go to the page you want to edit, and then on the Page tab, select Edit.

To add an app part to a content area

1.	 On the page where you want to add an app part, activate edit mode and place 
the cursor where you want the app part to be displayed.

2.	 On the Insert tab, in the Parts group, select App Part to open the app parts pane.

3.	 Select the app you want to add to your page.

The app parts pane shows an app part for each list or library on the site, in addition to app parts for 
apps you have installed

4.	 Select Add.
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To add a web part to a content area

1.	 On the page where you want to add the web part, activate edit mode and place 
the cursor where you want the web part to be displayed.

2.	 On the Insert tab, in the Parts group, select Web Part to open the web parts pane.

3.	 Under Categories, select a category, and then under Parts, select the web part 
you want to add to your page.

When a web part is selected, the About The Part section provides a description of the web part

4.	 Select Add.

To add an app part or web part to a web part zone

1.	 On the page where you want to add an app part or web part, activate edit 
mode, and then in the zone where you want to add the app part or web part, 
select Add a Web Part to open the web parts pane.

2.	 Under Categories, select a category, and then under Parts, select the web part 
you want to add to your page.

3.	 Select Add.

To display the Web Part tab and any other contextual tabs for a web part

1.	 In edit mode, select the check box for the web part by selecting the title bar of 
the web part.
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Select the web part’s title or check box to display contextual tabs

To open the web part tool pane

1.	 In edit mode, do one of the following:

●● Display the Web Part contextual tab, and then select Web Part Properties.

Use the Web Part tab to open the web part tool pane, create web part connections 
to related lists, and minimize, restore, or delete the web part

●● Point to the web part, select the arrow on the title bar of the app part or 
web part, and then select Edit Web Part.

Use the commands on the menu to minimize, close, or delete the web part or app part or to 
open the properties pane

TIP  The Web Part tab, web part menu, and web part tool pane can be opened 
only when you are editing the page. 
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To configure the content that a list or library app part displays

1.	 Open the web part tool pane as described in the previous procedure.

2.	 In the web part tool pane, immediately below List Views, do one of the 
following:

●● Select a view that was previously created from the list or library.

Use the List Views section to select the view you want the  
app part to use and to select the app part toolbar

●● Select Edit the current view, and then, if a dialog box opens, select OK to 
save your changes. The Edit View page is displayed. Configure what you 
want the web part to display, and then select OK.

TIP  You configure a view for an app part the same way you configure a view for 
a list or library. For more information about views, see Chapter 3, “Work with 

content in lists and libraries.”
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To move an app part or web part to another location on a page

1.	 With the page activated for editing, point to the title bar of the app part or web 
part so that the pointer changes to a four-pointed arrow.

2.	 Drag the web part to the new area on the page.

To remove an app part or web part from a page

1.	 Do one of the following:

●● Display the Web Part tab, and then in the State group, select Delete.

●● On the web part’s title menu, select Delete.

2.	 Select OK to confirm that you want to permanently delete the app part or web part.

To save modifications to a web part page

1.	 On the web part page, on the Page tab, select Stop Editing.

Skills review
In this chapter, you learned how to:

■■ Understand SharePoint pages

■■ Create pages

■■ Add content to pages

■■ Manage pages

■■ Use app parts and web parts
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Practice tasks
The practice files for these tasks are located in the SP2016SBS\Ch07 folder.

IMPORTANT  You must have sufficient permissions to perform the 
operations involved in each practice task to complete that practice task.  

For more information, see Appendix A, “SharePoint 2016 user permissions and 
permission levels.”

Understand SharePoint pages
There are no practice tasks for this topic.

Create pages
Go to a SharePoint team site where you have sufficient rights to create a page, and 
then perform the following tasks:

1.	 Create a wiki page named Wide World Importers.

2.	 Position your cursor in the content area, enter Wide World Importers, and 
then on a new line, enter We are specialist importers of unique furniture 
[[BedRoomFurniture|bedroom furniture]], [[OfficeFurniture|office furniture]] 
and [[GardenFurniture|garden furniture]] to create three wiki links.

3.	 Save the page.

4.	 Select the forward links to create the three pages, and on each page, create a 
link back to the Wide World Importers page before saving each page.

5.	 Create a web part page named Kitchen Furniture, using the Header, Left 
Column, Body layout, and save it in the Site Pages library.

6.	 Stop editing the page, and leave your browser open if you are continuing to the 
next set of practice tasks.
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Add content to pages
Go to the Wide World Importers page and activate it for editing, and then perform 
the following tasks:

1.	 Change the page layout to Two columns with header and footer.

2.	 Move the text Wide World Importers to the top area and style it as Heading 1.

3.	 In the left column content area, do the following:

●● Insert the pjcov.jpg picture from the practice file folder, saving the file in 
the Site Assets library.

●● Create a link to the Kitchen Furniture page, and then save the page but 
continue editing.

4.	 In the bottom content area, insert the Wildlife.wmv video from the practice file 
folder, saving the file in the Site Assets library.

5.	 Use the commands on the Media tab to set the video to Start Automatically 
and use a player style of Light.

6.	 Save and check in the page, leaving your browser open if you are continuing to 
the next set of practice tasks.

Manage pages
Go to the Wide World Importers page, and then perform the following tasks:

1.	 View all pages in the Site Pages library, and delete the Kitchen Furniture page.

2.	 Display the page history of the Wide World Importers page.

3.	 Compare the current version with version 2.0, and then restore version 2.0.

4.	 Create an alert on the page, retaining the default values.

TIP  If SharePoint is not configured to send email messages, an Error page will be 
displayed. If this page appears, you cannot complete the rest of the steps in this 

procedure. Check with your SharePoint administrator before you proceed. 

5.	 Activate the page for editing, delete the content in the top content area, and 
save the page.
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6.	 Check that you have received two emails, one stating that an alert was success-
fully created, and another stating that the page was modified.

7.	 Use Manage My Alerts to delete the alert you created on the Wide World 
Importers page, and then leave your browser open if you are continuing to the 
next set of practice tasks.

Use app parts and web parts
Go to the Wide World Importers page, and then perform the following tasks:

1.	 Activate the page for editing, and in the top content area, add an app part for 
the Site Assets library.

2.	 Open the Site Assets web part tool pane.

3.	 Change the title to Image and Video files and the Chrome Type to Title and 
Border, and prevent users from minimizing the app part.

4.	 Apply your changes.

5.	 Edit and save the current view so that the Modified and Modified By columns 
are not displayed in the app part.
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Index
A
About Me page  202–204
About This Blog web part  335
About This Community web part  348
About wiki page  348
Access 455–457
Activities filter  209
Add a Workflow page  400
Advanced Search  166
alerts  392

creating by using Outlook  454–455
creating on pages  263
for searches  161–162
setting up  92–95, 163

All Tasks view  375
Announcements list app  54
app launcher  24–25
app parts  44–45, 263–266

adding to pages  327–328
Documents  236
moving/removing on pages  269

application pages  239  See also pages
Approval Center  373
Approval - SharePoint 2010 workflow 

template  394, 402
Apps app part  263
apps, displaying all available on site  58
archiving history lists  401
articles  333
Asset Library app  56
association forms/pages  400, 406–408
attachments, configuring for lists  132
audio  253, 255–256
audit log reports, viewing  529–530
auditing

content types  526
user actions  529–530

Automatically Share Changes options  433
AutoText  429

B
background fill color, timelines  380
badges  355–356
barcodes, turning on for content types  527
Basic Search Center site template  280
best reply, assigning/unassigning as  360
BI (Business Intelligence)  461
BI server-side components  462
Blog Notification web part  335
blog posts  338

categories  333
comments  343–344
creating using browsers  340–341
deleting  343
images  336–337
liking  345
modifying  342

Blog site template  278, 281–282
blog sites  281, 334–338
Blog Tools web part  334
Blog web parts  263
blogging  333
blogging apps, linking blog sites  338–339
blogs  6
branding files, storing  252
browsers

adding files to libraries using  68
creating blog posts using  340–341
navigating to sites  274–275
opening document library documents  10
working with Access apps in  456–458

built-in workflow templates  393
Business Data web parts  264
Business Intelligence (BI)  461
Business Intelligence Center  463
Business Intelligence Center site template  279
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C
CAL (client access license)  15
Calendar list app  54
Calendar view  375
calendars  450–451
callouts

displaying in OneDrive for Business 
library  219

formatting  381
on timelines, displaying tasks as  378

Case Content web part  264
categories

adding to Enterprise Wiki sites  331
adding to wiki page library  326
blog posts  333
blog sites  337–338

Categories wiki page  347
charts  481–482
child sites  274, 283
child tasks  374
Circulations list app  54
classic mode  16
client access license (CAL)  15
closed term sets  168
cloud hybrid search  158–159
co-authoring  126, 431
code, embedding from other sources  257   

See also HTML
collaboration

co-authoring documents  431–434
sites  19
tools  7

Collaboration site templates  278–279
collaborative authoring  434
Collect Feedback - SharePoint 2010 workflow 

template  394
Collect Signatures - SharePoint 2010 workflow 

template  394
columns

creating  83–85
custom  129
deleting  87–88
modifing display  86–87
selecting to show on Welcome Page  505

comments  See blog posts
Community Members group  349
community members, monitoring  356
Community Moderators group  349
Community Owners group  349
Community Portal  346–347

Community Portal site template  280
Community Site template  279, 282
community sites  345

badges  355–356
configuring settings  351–352
creating  350
creating/deleting discussion 

categories  351–352
discussions  357–359
joining/leaving  357
lists  347–348
modifying discussion categories  351
monitoring members  356
open editing  237
reputation settings  354–356
SharePoint groups  349–350
types of pages  234
viewing membership information  357
web parts  348
wiki pages  347–348

Community Tools web part  348
Community Visitors group  349
Community web parts  264
Completed view  375
compliance details, displaying  513
Compliance Policy Center  496
Compliance Policy Center site template  279
contacts, copying from Outlook to SharePoint 

contacts  451
Contacts list app  54
content approval  392 

See also versioning
for lists  122
setting up for lists  124

Content By Search web part  346
Content Editor web part (CEWP)  235, 264, 335
Content Organizer  506–510
Content Query web part  264
Content Rollup web parts  264
Content Search web part  264
content types

adding site columns  140–143
adding to libraries/lists  143–144
associating document templates  143–144
auditing  526
creating custom  139–140
forcing updates  505
turning on barcodes  527
turning on labels  527–528
turning on/off  139

CAL (client access license)
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turning on retention  524–525
working with  138–139

contextual tabs  254, 266
conversationresults.aspx  183
conversations, locking/unlocking  217
Convert to XHTML, fixing HTML errors using  251
crawling  158–159
Current Site Title link  21
Custom List in Datasheet View list app  55
Custom List list app  54

D
Dashboards Library app  56
Data Connection Library app  57
data connections, supported data sources  470
Data Loss Protection (DLP)  514–515, 517
data models  470–473, 479
data protection policies  514–517
data sources, supported  470
datasheet view  63
dates, configuring on timelines  378–379
default.aspx  183
delete rules  516
deletion policies  517
Developer Site template  278, 281–282
devices, syncing libraries to  96
dialogs, configuring for lists/libraries  133
DIP (Document Information Panel)  428–429
disabling workflows  423
Discussion Board list app  55
discussion categories, community sites  351–352
discussions  358–361
Disposition Approval workflow  395, 397
Document Center  496–497
Document Center site template  279
document deletion policies  514, 516–517
document IDs  498–500
Document ID Service  498–499
Document Information Panel (DIP)  428–429
document libraries 

See also libraries
adding keywords to files  172
configuring Site Assets setting  137
editing document template  136
modifying default document open 

behavior  136–137
publishing worksheets to  467–468
setting up custom Send To destination  137
setting up document template for  136

Document Library app  57

document properties, updating  430
document sets  500–506
Document Sets web parts  264
document templates  136, 143–144
documents 

See also files
adding Quick Parts  429
alerts, setting up  93–94
checking in/out  77–80
configuring open behavior  135
creating from libraries  70–73
creating in Documents library  12
default names  13
discarding checkouts  80
drafts, publishing as major versions  127
editing in Office  428
editing in Office client programs  74–75
editing in Office Online  76–77
editing on mobile devices  10
following  94–95, 211
metadata  428–429
modifying open behavior  136
opening in browsers  134
sharing  116
stopping sharing  120
updating properties  430

Documents app part  236
Documents library  66

creating Word documents  12–13
default document names  13
displaying contents  236
opening  7
synchronizing  26

Documents link  21
Draft Item Security  123
drafts

permissions  123
publishing as major versions  127
versions  246

durable links  41–43

E
ebook edition of book  xv
ECM (Enterprise Content Management)  496
eDiscovery Center  496, 515
E-discovery Center site template  279
eDiscovery in-place hold policy  514
Edit link security options  117–118
Edit Policy page, displaying  523
Edit Source command  251

Edit Source command
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editing history for list items  122
embedding HTML code  253
Enterprise Content Management (ECM)  496
enterprise keywords  168, 171–172
Enterprise Search Center  463
Enterprise Search Center site template  234, 280
Enterprise site templates  279–280
Enterprise Wiki pages  332–333
Enterprise Wiki site template  234, 281
Enterprise Wiki sites  325, 328–330
errata, submitting  xv
event receivers  393
Everyone filter  209
Excel 2016

co-authoring limitations  431
data models  470
enabling PowerPivot for Excel add-in  472
metadata  429
PivotTables  473
Power View  477–479
starting workflows  414–415

Excel Online  462
co-authoring functionality  431
PivotCharts/PivotTables  473
viewing worksheets  466

Excel Services  14
Excel Web Access web parts  475–477
exporting data from spreadsheets  441–447
External List list app  55

F
farm level features  313
feedback, submitting  xv
File Explorer, displaying OneDrive for Business 

folder  224
files 

See also documents
adding to libraries  68–71
checking in/out from libraries  77–80
checking user access  119
configuring permissions inheritance  121
discarding checkouts  80
displaying callouts  43
displaying commands  40
displaying compliance details  513
displaying Permissions page  120
displaying shortcut menu  39
durable links  41–43
earlier versions, viewing  81–82
finding document IDs  500

Get A Link  117
monitoring workflow instances  415
QR code, obtaining  43
recovering deleted  224
removing access  119
renaming in libraries  43, 77
restoring earlier versions  82
selecting in libraries  42
setting unique permissions  121
sharing  116–118
sharing links  117
sharing via links  119
shortcut menu, opening  42
sync status  224
uploadig to synced libraries  224
version history, viewing  80
viewing synced  224

filtering
libraries/lists  88–90
search results  163

filters  89, 209
Filters web parts  264
Focus on Content  26
folders

checking user access  119
configuring availability  132
creating  82
removing access  119
sharing  116, 118, 120
sharing via links  119

folksonomy  167
Followed  220
following

documents  94–95, 211
people  210–211
#tags (hashtags)  211–212

Following filter  209
Form Library app  57
Forms web parts  264
forward links  239, 244–245
full-screen mode, Power View  479

G
Gantt Chart view  375
Get Started With Your Site web part  236, 264
global navigation bar  24
global term sets  168
grandchild sites  284
Group Approval workflow template  395

editing history for list items
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groups
adding users  353
removing users  299
types of  349

H
hashtags (#tags)  210–212, 216–217
history 

See also versions
displaying for pages  260
workflows  401–402

Home link  21
home pages  239–240

designating  260
navigation areas  20–21

Home wiki page  347
hover panel  160
HTML

displaying using forms  264
editing  251, 256–257
editing wiki pages  251
embedding  253
errors, fixing by converting to XHTML  251
inserting  256–257
selecting tags  251

HTML5  477
HTML iFrame tags  253
hybrid deployments, navigating  26
hybrid environments  3
hybrid federated search  158–159
hybrid OneDrive  206–207
hybrid site integration features  207

I
iFrames  254
images  254, 336–337
Image Viewer web part  235, 264
I’m following web part  209
Import Spreadsheet list app  55
importing data from spreadsheets  441–447
InfoPath  264, 393
information management policies  515

auditing content types  526
creating/modifying retention 

policies  524–526
displaying Edit Policy  523
displaying Information Management Policy 

Settings  522
generating file plan reports  528
library content types  521
list/site content types  521

location-based retention policy  522–523
schedules  521
site collections  520
turning on barcodes for content types  527
turning on content type retention  524–525
turning on labels for content types  527–528

in-page editing  32–34
in-place hold policies  515, 518
In-Place Hold Policy Center  496, 514
In-place Hold Policy Center site template  279
in-place record policies  514
in-place records  511–513
integration with Office  9–10
Issue Tracking list app  55
item-level permissions  128, 132
items, displaying compliance details  513

J
Join web part  348

K
keyboard shortcuts, displaying  250
Keyword Query Language (KQL)  165
keywords  168–169, 172
KPI List list app  55

L
labels  527–528
Languages and Translators list app  55
languages, tagging specific  251–252
Late Tasks view  375
layout, changing on pages  255
Layout group  250
_layouts directory  275
left navigation panel  4
libraries  20, 66–67 

See also document libraries
adding content types  143–144
adding enterprise keywords column  171–172
adding files  68–71
adding workflows  403–404
advanced settings  127, 134–136
changing user permissions  115
checking files in/out  78–79
checking user permissions  113–114
column display  86–87
configuration settings  104–105
configuring dialogs  133
configuring folder availability  132
configuring for ratings  149

libraries
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libraries (continued)
configuring in-place records 

management  512
configuring mandatory checkout  125–126
configuring validation settings  148
configuring versioning  124–126
connecting to Outlook  447–449
creating  67
creating columns  84–85
creating custom views  145–147
creating folders  82
creating for saving notebooks  437
custom Send To destinations  137
deleting  149
deleting columns  87–88
deleting items  90
descriptions  107–108
disconnecting from Outlook  449–450
displaying advanced settings  132
displaying Information Management Policy 

Settings page  522
displaying Permissions page  112
displaying Settings page  106
editing documents  74
editing document templates  136
enabling unique permissions  112
enforcing file checkout  127
excluding from search  132
exporting to Excel  441
filtering  88–90
folders, creating  82
generating file plan reports to  528
granting user permissions  113–115
manually starting workflow 

instances  412–413
modifying column display  86–87
naming  66, 106–107
navigating  38–39, 107–108
offline client availability  133
OneDrive for Business  218–219
organizing  82
Pages  238
permissions  108–111, 115
Quick Edit availability  133
reindexing  133
renaming files  43, 77
restoring  150
restoring items  91–92
restoring permissions inheritance  112
selecting files  42
settings  104–105

setting up document templates  136
sharing files/folders  116–117
Site Assets settings  137
Site Pages  237
sorting  88–89
stop syncing  228
syncing to devices  96
turning content types on/off  139
versioning  126
viewing size of OneDrive for Business 

(Documents)  228
wiki pages  237
and workflows  395

library app parts, configuring content 
display  268–269

library apps  56–59
library-based retention schedule  521
library content types, information management 

policies  521
Likes filter  209
liking microblogs  215
links

adding to site navigation  34
including in microblogs/replies  215–216
nesting  32
security options  117
sharing  116–117
sharing files/folders  119
to subsites  21

Links list app  55
list apps  54–58
list-based retention schedule  521
list content types

information management policies  521
modifying workflows  422

list items
alerts, setting up  93–94
allowing attachments  128
approving  124
attaching documents  65
configuring inheritance  121
deleting  90
displaying Permissions page  120
Draft Item Security  123
monitoring workflow instances  415
rejecting  124
restoring  91–92
selecting in lists  42
setting unique permissions  121
tracking editing history  122

list permissions  537–542

library app parts, configuring content display
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list workflow templates  See workflow templates
lists  20

adding content types  143–144
adding enterprise keywords column  171–172
adding items  62–64
adding workflows  403–404
advanced settings  127
attachments  132
configuration settings  104, 128
configuring content display  268–269
configuring dialogs  133
configuring folder availability  132
configuring for ratings  149
configuring in-place records 

management  512
configuring settings  104–105
configuring validation settings  148
configuring versioning  123
connecting to Outlook  447–449
content approval  122, 124
content types, associating with workflow 

templates  406
copying/moving items to Outlook  453–454
creating  59–61
creating columns  84–85
creating custom views  145–146
creating folders  82
creating from spreadsheets  441–442
creating from within Excel  443–446
deleting  149
deleting columns  87–88
descriptions  107
disconnecting from Outlook  449–450
display names, changing  61–62
displaying advanced settings  132
displaying Information Management Policy 

Settings page  522
displaying Permissions page  112
displaying Settings page  105
editing items  63, 65
enabling unique permissions  112
excluding from search  132
exporting data to Excel  445–446
filtering  88–90
folders, creating  82
generating file plan reports to  528
importing data from Excel  441–446
item-level permissions  128, 132
manually starting workflow 

instances  412–413

modifying column display  86–87
modifying workflows  421
name values  60
naming  60, 106–107
navigating  38, 107–108
offline client availability  133
offline viewing  130
organizing  82
permission levels  109–111
permissions  108–109
Quick Edit availability  133
reindexing  130, 133
restoring  150
restoring permissions inheritance  112
selecting items  42
sorting  88–89
turning content types on/off  139
user permissions  113–115
and workflows  394–395

local term sets  168
location-based retention policy  521–522
locking conversations  217

M
major/minor versions  125, 127, 246
managed terms  168
mandatory checkout  125–126
Markup group  251
markup, HTML  256–257
Media and Content web parts  264
Media group  252
members, monitoring  356
Members permission level  288, 292–293
Members wiki page  347
membership information, viewing  357
Mentions filter  209
messages, posting  213
metadata  164–168, 428–429
microblogs  209, 213–217
MicroFeed web parts  209, 213
Microsoft Excel  See Excel 2016
Microsoft IME Dictionary List list app  55
Miscellaneous web parts  264
mobile devices, editing documents  10
modern user experience  15
modifying user profile properties  204
monitoring

discussions  361
site workflows  415
workflow instances  409, 415

monitoring
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My Membership web part  348
My Site  202–203
My Site Host site template  280
My Tasks view  375

N
name values in lists  60
naming

URLs  277
workflows  400

navigation  20–21
customizing  31–32
grandchild sites  284
top link bar  21, 284

Newsfeed page  202, 208–211
newsfeed web part  209
newsfeeds  20, 25

displaying  27
posting to  7

notebooks  435–440
notification area  223
notifications, RSS feeds  454 See also alerts

O
Office 365  2

OneDrive  207
Power BI  463

Office 365 SharePoint features  411
Office 2016

co-authoring documents  431–434
editing documents in  428
integration with SharePoint  9–11

Office apps, creating/publishing  281
Office client programs, editing library 

documents  74
Office mobile apps  10
Office Online

co-authoring documents  431–434
creating library documents  70–72
editing library documents  76–77

Office Online apps  10
Office Online Server (OOS)  10, 470
Office products, co-authoring functionality  431
off-premises  2
OneDrive

hybrid  206–207
Office 365  207

OneDrive for Business  25, 202
differences from OneDrive  218
displaying  27, 224–225

library  218–221
sync client  222, 229–231
syncing to SharePoint library  227
Recycle Bin, opening in browser  226–227
redirection  206

OneDrive Personal folder, displaying  225
OneNote  431, 439
OneNote Class notebooks  436
OneNote notebooks  See notebooks
OneNote Online  431, 435
on-premises  2, 27
OOS (Office Online Server)  10, 470
open editing  237
open term sets  168
Outlook

connecting lists/libraries to  447–449
copying/moving items to/from 

SharePoint  451–452
creating SharePoint alerts  454–455
disconnecting libraries/lists from  449–450
displaying connected calendars  450
overlaying calendars  450
RSS feeds  453

Owners permission level  288, 292–293

P
page layouts  238, 246–247
page navigation, displaying/hiding  28
Page Viewer web parts  484–486
pages 

See also webpages; wiki pages; publishing 
pages

adding app parts  327–328
adding content using web parts  264
adding Project Summary web parts  369
application  234, 239
changing layout  255
checked out status  245
comparing versions  261
creating  239–246
creating alerts  263
customizing  234
deleting  262–263
designating as home pages  260
displaying history  260
editing  26
embedding code  257
formatting  255–257
inserting audio/video  253
inserting pictures  252

My Membership web part
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List Settings  239
modifying  245–249
monitoring workflow instances  415
moving app parts/web parts  269
publishing  234
removing app parts/web parts  269
restoring deleted  263
reverting to previous versions  261
ribbon, displaying/hiding  38
system  239

Pages library  246, 260
parent sites, navigating to subsites  30
people

following  210–211
mentioning in microblogs/replies  216
searching for  188–190

PerformancePoint Content List list app  56
PerformancePoint Services  462
permission levels  290–293 

See also permissions; site permissions
categorized by scope  537–542
changing  301–302
copying  302–303
creating  300–301
default  8, 109–110, 533–536
deleting  301
list permissions  291
Members group  292–293
Owners group  292–293
personal permissions  292
removing  537
site permissions  290–291
Visitors group  292–293

Permissions page, displaying  112, 120
permissions 

See also permission levels; site permissions
assigning to sites  282–284
changing for users  115
checking for users  113–114
child sites  283
configuring inheritance  121
default  109
draft items  123
granting for users  113–115
inherited  108–109, 111–112, 287
lists  108
libraries  108
open editing  237
personal  537–542 
removing from users  115
restoring inheritance  112

site templates  282
unique  111–112, 121, 289
by user group  288

personal blog sites, creating  335
personal sites, creating  285–287
Picture command  252
Picture Library app  57
pictures

formatting  256
including in microblogs  217
including in replies  217
inserting  252, 255–256

pinning sites  205
PivotCharts, PivotTables  473–477
policies  514–515
posts  333
Power BI, program compatibility  463
Power Map, creating with pie charts  482–483
PowerPivot  464

analyzing data in dashboard  475
creating sites  469
dashboards  473

PowerPivot for Excel  470, 472
PowerPivot Gallery  465

creating in team sites  468
opening Power View reports  480
switching views  469
views  466

PowerPoint
co-authoring functionality  431
editing metadata  429
starting workflows  414–415

PowerPoint Online, co-authoring 
functionality  431

Power View  477–483
about  461
deploying  462
displaying reports in Page Viewer web 

parts  484–486
practice files  xii–xv
previewing search results  160
Process Diagram Library app  57
Product Catalog template  234
profile page, deleting/hiding activity  204
Project Center  373
project features, adding to team sites  368–369
project plans  374, 384, 387
Project Professional, syncing project plans to 

new SharePoint sites  384
Project Server 2016 project sites  371–373

Project Server 2016 project sites
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Project Site template  278
project sites

Project Server 2016  371–373
SharePoint 2016  366–371

Project Summary web part  264, 366–367
adding to pages  369
modifying properties  370–371

Project Tasks list app  56
Project Web App site  366, 373–374
Promoted Links list app  56
property controls  429
protecting data, policies  514
Publishing Approval workflow  397
Publishing Approval workflow template  395
publishing pages  234, 238–239

changing layout  255
checking in  248
content area  238
creating  243–245
discarding modifications  248–249
displayed by forward links, creating  244–245
editing  246–247
formatting  250
publishing  248
reusable content  259
saving modifications  248–249

Publishing Portal template  234
Publishing Site templates  234, 280
Publishing site with workflow site template  280
Publishing Site with Workflow template  234
publishing templates  238

Q
QR (Quick Response) code  41–43
queries  515
query rules  173–179
Quick Edit  63, 374

adding list items  64
allowing  130
configuring availability  133
creating columns  85–86

Quick Launch  4
customizing sites  34–35
customizing using in-page editing  32–33
displaying/hiding  30
links  21
Newsfeed page  208
OneDrive for Business library  219–220
PowerPivot Gallery  468

Quick Launch zone  334
Quick Parts  429–430

R
rating controls  148–149
rating discussions  361
Rating settings  148–149
reading mode, Power View  479
Really Simple Syndication (RSS)  281, 315–316
real-time co-authoring  432–433
real-time typing  432
Reassign Task option  418
Recent  220
Recent link  21
Record Library app  57
Records Center  496–497
Records Center site template  279
records management  510–513
Recycle Bin  20, 90, 220

link  21
opening  46
removing/restoring items  46, 312
second-stage, opening  47
second-stage, restoring items  47

Refinement web part  184
refining search results  163
refreshing external table data  446
reindexing lists/libraries  130, 133
reindexing sites  187–188
relevance rank of search results  173
replies  216–218, 360
Report Library app  57
Reports Center  373
reputation settings  354–356
Request Change option  418
Resource Center  373
restoring items  91–92
Restricted link security option  117
results.aspx  183
retention policies  524–526
reusable content  257–259
reusable workflows  411
ribbon  36–38
roles  399–400
RSS (Really Simple Syndication) feeds  315–316, 

392
adding to Outlook  453
syndicating blog site contents  281

S
Script Editor web part  264
scripting, security risks  254
Search Box web part  183
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Search Center  161–163
linking to  180
searching for people  190
setting up URLs for sites/site collections  181
web parts  183

Search-Driven content web parts  264
search index  158–159
search queries  164–167
search results 

See also searches
changing pages  181
configuring site visibility in  187–188
customizing pages  182–187
filtering  163
page  159–160
promoting  178
ranking  173
relevance ranking  173
web parts  183–184

Search Results web part  183
Search settings  179–180
search verticals  161, 180, 182
Search web parts  264
searches 

See also search results
alerts  161–163
changing results pages  181
configuring behavior of  179–180
configuring navigation for sites  181–182
excluding lists  129
excluding lists/libraries  132
filtering results  163
forcing site reindexing  187–188
hybrid  158–159
promoting results  178
query rules  173–179
ranking results  173
refiners  163, 168
relevance rank  173
site indexing/visibility  187

searching
for people  188–190
metadata  164–165
SharePoint deployments  162
SharePoint sites  162

security, scripting risks  254
self-service BI  462
Self-Service Site Creation (SSSC)  285
Send To destination  137
shared column  138
SharePoint 2010 workflows  394–395, 403

SharePoint 2013 workflows  420–421
SharePoint 2016 BI  462
SharePoint 2016 project sites  366–371
SharePoint Designer  393
SharePoint Foundation  14
SharePoint groups  See groups
SharePoint Help  4–5
SharePoint library, syncing to  227
SharePoint lists  See lists
SharePoint Online  2, 15

BI features  463
displaying followed sites  27

SharePoint products  13
SharePoint Server 2007 workflow templates  397
SharePoint Server 2016

available editions  14–15
deprecated features  14
hybrid environment  3
supported data connections  470
updated features  13–14
workflow templates  394–395

sharing
documents  116
files  118–120
folders  118–120
links to documents  116
removing access  119
security options  117
sites  303–308
stopping  120
via links  119

shortcut menu  39, 42
Silverlight  131
Silverlight web part  484
Site Assets library  136–137
site assets, storing  136
Site closure policy  514
site collection features  397
site collections  28–29

activating/deactivating features  397, 497
auditing user actions  529
changing search results pages  181
configuring in-place records 

management  511–512
creating  284
Disposition Approval workflow  397
information management policies  521
Publishing Approval workflow  397
redeploying templates in  309
removing templates  312
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site collections (continued)
setting up Search Center URL  181
turning document IDs on/off  499
uploading templates  311
viewing audit log reports for  529–530
workflows  397

site columns  138, 140–143
site content syndication  315–316
site content tree  29–31
site content types

associating workflow templates  405
information management policies  521
modifying workflows  422

Site Contents link  21–22
site features  313–315
Site Feed web part  236
Site Folders  220
site home page  3–4
site integration features  207
site navigation  20

adding links  34
customizing  31–32
Focus on Content  26

site newsfeeds, posting to  7
Site Pages  324
Site Pages library  237, 260
site permissions  537–542 

See also permissions; permission levels
changing  298
checking  297
granting  297–298
individual  290–293
inherited  287, 289
library access  291
list access  291
managing  294
managing for parent sites  297
Members group  288, 292–293
Moderators group  293
Owners group  288, 292–293
personal web parts/pages  292
removing from users  299
restoring inheritance  296
site access  290
unique  289, 295–296
Visitors group  288, 292–293

site policies  518–519
site structure components  28–29
site templates  278, 496 

See also templates
activating  311

availability  282
Basic Search Center  280
Blog  278
built-in  278–281
Business Intelligence Center  279
categories  278–281
Collaboration sites  278–279
Community Portal  280
Community Site  279
Compliance Policy Center  279
custom  282, 307–309
deactivating  312
Developer Site template  278
Document Center  279
downloading  310–311
E-discovery Center  279
Enterprise Search Center  280
Enterprise sites  279–280
Enterprise Wiki  281
In-place Hold Policy Center  279
My Site Host  280
permissions  282
Project Site  278
Publishing sites  280
Publishing site with workflow  280
Records Center  279
redeploying in site collections  309
removing from site collections  312
supported capabilities  307
Team Site  278
unsupported capabilities  307–308
uploading to site collections  311

site themes  305–307
site users, permissions  287–288
site workflows  414–415  See also workflows
sites 

See also websites
applying site policies  519
assigning permissions  282–284
availability of workflows  399
changing search results pages  181
checking user access  304–305
components  28
configuring RSS feed  316
configuring search navigation  181–182
controlling access  8
creating  285–287
customizing Quick Launch  34–35
customizing top link bar  35
deleting  316
displaying all apps  58
displaying library apps  58–59
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displaying Permissions page  295
displaying Site Contents page  27
displaying Site Settings page  27
features  313–315
following  27
following changes  26
following/stop following  204–205
manually closing  520
navigation options  284–285
opening  4–6
opening closed  520
pinning to Sites page  205
postponing deletion of  520
Recycle Bin, opening  46
reindexing  187–188
removing users from groups  299
saving as templates  309
setting up Search Center URL  181
sharing  8, 26
structure  28–30
unpinning from Sites page  205
user groups  288

Sites link  25
slicers, adding to charts  481
Social Collaboration web parts  264
sorting lists  88–89
spelling, checking discussions for  358
spreadsheets 

See also worksheets
creating lists from  441–442
exporting data to  441
exporting data to SharePoint  443–446
importing data from SharePoint  441–443

SQL Server 2016 PowerPivot, deploying  462
SQL Server Reporting web parts  264
SSSC (Self-Service Site Creation)  285
Status List list app  56
status, workflows  410–411
subsites

creating  496–497
navigating from parent sites  30

subtasks  374–375, 377–378
Survey list app  56
surveys  20
sync clients  218

differences between  222–223
icons  223
limitations  230–231
OneDrive for Business  222
OneDrive for Business Next Generation  222

synced files  224

synced folders, opening in browsers  226
synced libraries

opening in browsers  226
uploading files  224

synchronization
configuring for notebooks  440
notebook errors  436

synchronizing Documents library  26
syncing

libraries to devices  96
notebooks manually  439–440
OneDrive for Business library to 

computer  221
pausing/resuming  227–228

syndicating blog site content  281
system pages  239

T
targeted search queries  164–168
task bars, formatting  381
Task Center  373
task items, viewing all  418
task lists

items removed automatically  401
moving tasks up or down  376
naming  401
syncing with Project Professional project 

plan  385–386
turning timelines view on/off  382–383
views  375
and workflows  401–402

tasks
adding to timelines  377
copying from Outlook to SharePoint  451–452
displaying as callouts on timelines  378
indenting/outdenting  376
moving between timeline bars  381
moving in task lists  376
on timelines, displaying as callouts  378
removing from timelines  378
synchronizing between SharePoint and 

Project  384
Tasks list app  56
taxonomies  167, 169
team blog sites, creating  335
team collaboration  6–7
team sites

adding project features  368–369
components  20
creating PowerPivot Gallery in  468
open editing  237

team sites

555



Team Site template  278, 281
templates 

See also document templates; site templates; 
workflow templates

custom  307–309
Enterprise Search Center  234
Enterprise Wiki  234
Product Catalog  234
publishing  238
Publishing Portal  234
Publishing Site  234
Publishing Site with Workflow  234
saving sites as  309
sites  278–283

terminating workflow instances  409, 411, 
416–417

term sets  168, 170
term store  168–169
Term Store Management Tool, opening  169
terms  168, 170–171
text, formatting on pages  255
themes  See site themes
Three-state workflow template  394, 402
tiles  54–57
time-based in-place hold policies  514, 518
timeline bars  380–381
timeline view, turning on/off for task 

lists  382–383
Timeline web part  382–383
timelines  376–381
top-level sites  28, 274
top link bar, customizing  33–35
top navigation area  4
tracking discussions  361
Translation Management workflow 

template  395
Trending #tags web part  210

U
unlocking conversations  217
unpinning sites  205
Upcoming view  375
URLs, naming  277
user actions, auditing  529
user interface  16
user permissions  533–542
user profiles  190–192, 204

users
adding to groups  353
checking permissions  113–114
group permissions  288
removing groups  299

V
validation settings, configuring  147–148
version history, viewing files  80
versioning  80, 122–126  See also content 

approval
versions

See also history
comparing for pages  261
files, viewing earlier  81–82
major/minor  80, 246
restoring  82
reverting to previous  261

videoresults.aspx  183
videos  253, 255–256
View link - no sign-in required security 

option  118
View link security option  117
views  144–147
Visio, co-authoring  431, 434
Visio Services  462
Visitors permission level  288, 292–293

W
web application level features  313
Web Content Management (WCM)  238, 496
web log  6  See blogs
web part connection  236
web part pages  234–236 

See also pages
adding content  245
creating  241–242
creating interactive pages  236
disadvantages  236
editing  265
free-format static images/text  235
saving modifications  269
Search Center  183
sending data  236
zone layout  235
zones  334–335

web parts  23
About This Community  348
adding to content areas  266
adding to web part zones  266
blogs  263
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Wiki Page Library app  57
wiki pages  234, 236–238 

See also pages
categorizing  326
changing layout  255
checking in/out  247–248
community sites  347–348
creating  240–242
creating web addresses for  240
discarding modifications  248–249
displaying by forward links  244–245
editing  246–247
editing format using HTML  251
formatting  250
grouping by category  327–328
linking to web part pages  243
saving modifications  248–249

Wikipedia  324
WikiWikiWeb  324
Word

co-authoring functionality  431
creating library documents  73–74
editing metadata  429
starting workflows  414–415

Word Online
co-authoring functionality  431
creating library documents  70–71

workbooks
exploring data models  472
opening data models in Power View  479

workflow instance  409, 411, 411–417, 423
Workflow Manager  393
workflow participant role  399
workflow roles  399 
workflow site collection features, 

activating  398–399
workflow status  410–411
workflow tasks  416–418  See also workflows
workflow templates

activating  394–397
Approval - SharePoint 2010  394
associating to list content types  406
associating to site content types  405
changing  419–420
Collect Feedback - SharePoint 2010  394
Collect Signatures - SharePoint 2010  394
Disposition Approval  395, 397
Group Approval  395
list  394
Publishing Approval  395, 397

built-in  263–264
business data  264
categories  263–264
community  264
Community Tools  348
content rollup  264
deleting  265
displaying contextual tabs  266
displaying on webpages  45
document sets  264
editing  44
Excel Web Access  475
filters  264
forms  264
Get Started With Your Site  236
I’m following  209
Join  348
media and content  264
miscellaneous  264
moving on pages  269
My Membership  348
Newsfeed  209
pages for searches  183
Page Viewer  484–486
Project Summary  366–367, 370–371
Refinement  184
removing from pages  269
search  264
Search Box  183
search-driven content  264
Search Results  183
Silverlight  484
Site Feed  236
social collaboration  264
SQL Server reporting  264
stacking  235
tool pane  267–268
Trending #tags  210
What’s Happening  348

webpages 
See also pages
displaying web parts  45
types of  234

Welcome Page  505
What’s Happening web part  348
wiki  6
wiki links  239, 243
Wiki Page Home Page site feature, 

activating  325
wiki page library  324–326
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workflow templates (continued)
SharePoint 2007  397
SharePoint 2010  394
SharePoint Server 2007  397
SharePoint Server 2016  394
Three-state  394, 397
Translation Management  395

workflows  392
adding  399–409
adding to libraries/lists  403–404
associated with content types  404–405
automatically starting  402
availability within sites  399
building  393
built-in  393
completing association forms/

pages  406–407
deleting/disabling  423
displaying  420
history lists  401–402
interacting with  409–420
and libraries/lists  395
managing  419–423
manually starting  402, 414–415
modifying for lists  421
modifying list/site content types  422
monitoring all for sites  420–421
naming  400
reusable  397, 411
roles  399–400
SharePoint 2010  393, 403
SharePoint 2013  393
SharePoint 2013, monitoring for 

sites  420–421
start options  402
task lists  401–402
Visio representations  411–412

working offline  11, 95–96, 223
worksheets 

See also spreadsheets
exporting/importing data  441
publishing to document libraries  467–468

viewing in PowerPivot Gallery  465–466

X
XHTML, fixing HTML errors  251

Z
zones  234–235, 266
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